BUSINESS & CORPORATE

ENGLISH

EMPOWERING OUR STUDENTS AND
PREPARING THEM TO BE BUSINESS LEADERS

Instructor:

Emir A. Liguori

Email:

aliguori@fdu.edu

Phone:

973-896-8471




TABLE OF CONTENT

CLASS DESCRIPTION

1. COVER PAGE
2. SYLLABUS
3. COURSE OUTLINE

COURSE MATERIAL

PUNSTUATION RULES

MODERN LAGUAGE ASSOCIATION FORMAT (MLA)
RESUME WRITING

EMAIL WRITING

BUSINESS LETTERS

BUSINESS LETTERS WORDS AND PHRASES
BUSINESS AND CORPORATE LANGUAGE

COMMON PHRASAL VERBS

WORDS AND PHRASES — BY BUSINESS AREA
10.TELEPHONE EDUCATE

11.SPANISH TO ENGLISH; CORRECTING MISUSE
12.COLLOCATION

13.SIGNPOSTS FOR PRESENTATIONS; INSTRUCTIONAL POWER POINT
14. CONCISE WRITING EXERCISES

15.BUSINESS ACRONYMS

16.MODAL AUXILIARIES

17.MICROSOFT TUTORIALS; HANDS ON INSTRUCTION

© © N o g Bk~ w DN E



Course Outline

Period Days Class Content
Syllabus Overview - Policy/Procedure
Week 1 Class Ground Rules
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Punctuation Rules
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Benchmark | — “ORAL”
Week 5 Business and Corporate Language
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PUNCTUATION RULES

PERIOD
1. Use a period at the end of a sentence.
Example: | enjoyed the movie.
2. Use a period after an initial.
Example: M. E. Kerr is a wonderful author.
3. Use a period after an abbreviation.
Example: We welcomed Mrs. Simmons to our team.
4. Use a period as a decimal point.
Example: The workers received a 2.1 percent raise.
5. Use a period to separate dollars and cents.
Example: The book cost $4.95.
6. Use a period after each number in a list printed vertically.
Example: For the example, look at the lists on this page.
EXCLAMATION POINT

1. Use an exclamation point at the end of sentence, phrase, or word to indicate strong emotion. (Never use more
than one exclamation point.)

Example: Wow! I never thought Mom would let us go to the concert!

QUESTION MARK
1. Use a question mark at the end of a question.
Example: Did Steven go with you?

2. Use a question mark at the end of a declarative statement that you want to emphasize as not believing the
statement.

She's our new teacher?

3. Use a question mark with parentheses to indicate that you are not sure of a spelling or other fact.
I have to visit an orthopeadic (?) doctor next week.
COMMA

1. Use a comma after each item in a series of at least three items. (It has become acceptable to omit the comma
before the conjunction in a series. However, it is important to remain consistent.)

Example: I still need to take a test, write an essay, and check out a book.

Example: | dislike spinach, broccoli, and cauliflower.
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Acceptable: | dislike spinach, broccoli and cauliflower.

Use commas after the street address and city in an address. (Do not use a comma after the state.)

Example: The address is 1234 Apple Street, Midtown, Kansas 98765.

Use a comma after the day and the year in a date. (No commas are used in dates when using the MLA style.)
Example: Connie's birthday is February 20, 1965.

MLA version: Connie's birthday is 20 February 1965.

Use a comma to clarify large numbers. Counting from right to left, a comma is needed after every 3 digits. This
rule does not apply to years, where no commas are used at all.

Example: In 1998 the population of Claremont was 23,899.
Use a comma to set off an interruption in the main thought of a sentence.
Example: Rosa, of course, will bring her folding chairs.

Use a comma to separate two or more adjectives that equally modify the same noun. (If you aren't sure whether
to use a comma to separate the adjectives or not, say the sentence with the word and in place of the comma. If it
makes sense, then use the comma.)

Example: Jill was having problems with the unruly, disruptive children.

Use a comma after a dependent clause that begins a sentence. (Never use a comma before a dependent clause at
the end of a sentence.)

Example: If Mr. Wilson complains, we'll invite him for a snack.
Example: We'll invite Mr. Wilson for a shack if he complains.

Use a comma before the conjunction in a compound sentence. However, if the two independent clauses are very
short, you do not need the comma.

Example: We had a lot of fun, so I'll have another party soon.
Example: She spoke and | took notes.

When quoting, put a comma to the left of a quotation mark that does not already have a period, question mark,
or exclamation point. (It is much easier to remember this rule than to worry about "inside” and "outside™.)

Example: Ariel said, "I knew you would win the contest."
Use a comma after a mild interjection, such as oh or well.
Example: Oh, the test was not that difficult.

Use a comma after a noun of direct address.

Example: Kodi, didn't I ask you to clean your room?

Use a comma after the greeting in a personal letter.
Example: Dear Aunt Sheila,

Use a comma after the closing of a letter.
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Example: Sincerely,

Use a comma to indicate where a pause is necessary in order to avoid confusion. (Sometimes rewriting the
sentence is a better choice.)

Example: After Kelly, Jennifer gets a turn.
Example: Maria came in, in quite a hurry.

Use a comma after an appositive. (An appositive is a noun or noun phrase that gives additional information
about the noun that it follows. Do not use a comma after a restrictive appositive, which is one that cannot be
removed from the sentence without changing the meaning of the sentence.)

Example: Wesley, my brother, is an optician.
Use a comma to set off the abbreviation etc.

Example: | went to the store to get napkins, plates, cups, forks, etc.

SEMICOLON

Use a semicolon to join two independent clauses. (This eliminates the need for a comma and a conjunction.)
Example: Casey read a book; then he did a book report.

Use a semicolon to separate items in a series when those items contain punctuation such as a comma.
Example: We went on field trips to Topeka, Kansas; Freedom, Oklahoma; and Amarillo, Texas.

COLON

Use a colon between numerals indicating hours and minutes.

Example: School starts at 8:05 a.m.

Use a colon to introduce a list that appears after an independent clause. (Introductory words such as following
go somewhere before the colon to help introduce the list.)

Example: You need the following items for class: pencil, pens, paper, ruler, and glue.
When mentioning a volume number and page number, use a colon between the two items.
Example: You will find information about Mexico in Grolier Encyclopedia 17:245.

Use a colon after the greeting of a business letter.

Example: Dear Sir:

Use a colon between the title and subtitle of a book.

Example: Reading Strategies That Work: Teaching Your Students to Become Better Readers is an excellent
resource.

Use a colon between the chapter and verse numbers for parts of the Bible.

Example: Please read Genesis 1:3.
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APOSTROPHE

Use an apostrophe in a contraction to show where letters have been omitted, or left out.
Example: | don't think I can do this. (The apostrophe shows that the letter

Use an apostrophe when you leave out the first two numbers of a year.

She was in the class of '93.

For a singular noun that does not end in -s, add 's.

Example: The lady's hands were trembling.

For a one syllable singular noun that ends in possessive.

Example: It is my boss's birthday today.

If a singular noun has more than one syllable and ends in -s it is acceptable to use 's OR to use only an
apostrophe after the -s. (It is important to remain consistent.)

Example: The metropolis's citizens were very friendly during our visit.
Acceptable: The metropolis' citizens were very friendly during our visit.

To form the possessive of a singular proper noun ending in -s, it is acceptable to add 's OR to add only an
apostrophe. (It is important to remain consistent.)

Example: Mr. Ness's classroom is very inviting.

Acceptable: Mr. Ness' classroom is very inviting.

If a plural noun ends in -s, add an apostrophe after the -s.

Example: The ladies' restroom was a mess.

If a plural noun does not end with an -s, form the possessive by using an apostrophe before an -s.

Example: The mice's tails were caught in a trap.

For a compound noun, place the possessive ending after the last word.

Example: My mother-in-law's car was in the garage during the hail storm. (singular)

Example: My brothers-in-law's cars were damaged in the hail storm. (plural)

To show possession of the same object by more than one noun, only make the last noun in the series possessive.
Example: I'm looking for Mrs. Garcia, Mrs. Lee, and Miss Carter's office. (They all share the same office.)
Example: I'm looking for Mrs. Garcia's, Mrs. Lee's, and Miss Carter's offices. (Each person has her own office.)
Use an apostrophe to form the plural of a number, letter, sign, or word used as a word.

Example: Check to see that you used the +'s and -'s correctly.

QUOTATION MARKS

Use quotation marks before and after a direct quote. If the speaker tag interrupts the quoted material, then two
sets of quotation marks are needed. However, do not put quotation marks around the speaker tag.



Example: "I think my leg is broken," Jesse whimpered.

Example: Did Mrs. Steele just say, "We are going to have a test today"?

Example: "I can't move." Maria whispered, "I'm too scared."

Put quotation marks around the titles of short works, such as articles, songs, short stories, or poems.
Example: Have you heard the song "Love Me Tender," by Elvis Presley?

Place quotation marks around words, letters, or symbols that are slang or being discussed or used in a special
way. (Underlining can be used for the same purpose.)

Example: | have a hard time spelling "miscellaneous."

Example: | have a hard time spelling miscellaneous.

Use single quotation marks for quotation marks within quotations.

Example: "Have your read the poem, 'The Raven,' by Edgar Alan Poe?" | asked Chris.

Any punctuation used goes to the left of a quotation mark. However, if the punctuation is used to punctuate the
whole sentence and not just what is inside the quotation marks, then it goes to the right.

Example: Have you read the poem, "Anabel Lee"?

ELLIPSIS

Use an ellipsis to indicate a pause.

Example: You mean ... | ... uh ... we have a test today?

Use an ellipsis to indicate omitted words in a quotation.

Example: "Then you'd blast off ... on screen, as if you were looking out ... of a spaceship.”

If the ellipses comes at the end of your sentence, you still need end punctuation, even it is a period.

I listened carefully as the teacher read Lincoln's inaugural address. "Four score and seven years ago ....

HYPHEN

Use a hyphen in compound numbers from twenty-one to ninety-nine.
Example: The final score was seventy-eight to sixty-two.

Use a hyphen between the numbers in a fraction.

Example: | only used three-fourths of the flour you gave me.

Use a hyphen to form some compound words, especially compound adjectives that appear for the nouns they
modify.

Example: The court took a ten-minute recess.

Use a hyphen to join a capital letter to a word.



Example: | had to have my arm X-rayed.

Use a hyphen to show a family relationship, except "grand” and "half."
Example: My sister-in-law helps take care of my great-aunt.

Example: We are going to go visit my grandparents while we are in town.

Example: Connie just found out that she has a half sister.

DASH

Use a pair of dashes to indicate a sudden interruption in a sentence. (One handwritten dash is twice as long as a
hyphen. One typewritten dash is one hyphen followed by another.)

Example: There is one thing--actually several things--that | need to tell you.
Use a dash to attach an afterthought to an already complete sentence.
Example: Sarah bought a new pet yesterday--a boa constrictor.

Use a dash after a series of introductory elements.

Example: Murder, armed robbery, assault--he has a long list of felonies on his record.

PARENTHESES

Use a set of parentheses around a word or phrase in a sentence that adds information or makes an idea more
clear. (Punctuation is placed inside the parentheses to mark the material in the parentheses. Punctuation is placed
outside the parentheses to mark the entire sentence. When the material in parentheses is longer than one
sentence [such as this information], then the punctuation for the final sentence is placed inside the parentheses.)

Example: Your essay (all nine pages of it) is on my desk.

Do not use parentheses within parentheses. Use brackets in place of the inner parentheses.

Example: Please refer to Julius Caesar (Act IV, scene i [page 72]).

BRACKETS

Use brackets around around words of your own that you add to the words of someone you are quoting.

Example: The news anchor announced, "It is my sad duty to inform our audience that we are now at war [with
Irag].”

UNDERLINING (OR ITALICS)
It is more acceptable to use italics when available.

Underline titles of long works such as books, magazines, albums, movies, etc. (Do not underline end
punctuation.)

Example: We use The Language Handbook to study grammar.




Example: We use The Language Handbook to study grammar.

Underline foreign words which are not commonly used in everyday English.
Example: If you look closely, you'll see e pluribus on most U.S. currency.
Example: If you look closely, you'll see e pluribus on most U.S. currency.

Underline a word, number, or letter which is being discussed or used in a special way. (Quotation marks can be
used for the same purpose.)

Example: Remember to dot every i and cross every t.
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MLA FORMAT

MLA (Modern Language Association) style is most commonly used to write papers and cite sources within the liberal arts and
humanities. This resource, updated to reflect the MLA Handbook for Writers of Research Papers (7th ed.) and the MLA Style
Manual and Guide to Scholarly Publishing (3rd ed.), offers examples for the general format of MLA research papers, in-text
citations, endnotes/footnotes, and the Works Cited page.

Please use the example at the bottom of this page to cite the Purdue OWL in MLA.

To see a side-by-side comparison of the three most widely used citation styles, including a chart of all MLA citation guidelines, see
the Citation Style Chart.

General Format

MLA style specifies guidelines for formatting manuscripts and using the English language in writing. MLA style also provides
writers with a system for referencing their sources through parenthetical citation in their essays and Works Cited pages.

Writers who properly use MLA also build their credibility by demonstrating accountability to their source material. Most
importantly, the use of MLA style can protect writers from accusations of plagiarism, which is the purposeful or accidental
unaccredited use of source material by other writers.

If you are asked to use MLA format, be sure to consult the MLA Handbook for Writers of Research Papers (7th edition). Publishing
scholars and graduate students should also consult the MLA Style Manual and Guide to Scholarly Publishing (3rd edition). The MLA
Handbook is available in most writing centers and reference libraries; it is also widely available in bookstores, libraries, and at the
MLA web site. See the Additional Resources section of this handout for a list of helpful books and sites about using MLA style.

Paper Format & General Guidelines

e  Type your paper on a computer and print it out on standard, white 8.5 x 11-inch paper.

o Double-space the text of your paper, and use a legible font (e.g. Times New Roman). Whatever font you choose, MLA
recommends that the regular and italics type styles contrast enough that they are recognizable one from another. The
font size should be 12 pt.

e Leave only one space after periods or other punctuation marks (unless otherwise instructed by your instructor).

e Set the margins of your document to 1 inch on all sides.

e Indent the first line of paragraphs one half-inch from the left margin. MLA recommends that you use the Tab key as
opposed to pushing the Space Bar five times.

o Create a header that numbers all pages consecutively in the upper right-hand corner, one-half inch from the top and
flush with the right margin. (Note: Your instructor may ask that you omit the number on your first page. Always follow
your instructor's guidelines.)

e Use italics throughout your essay for the titles of longer works and, only when absolutely necessary, providing
emphasis.

o If you have any endnotes, include them on a separate page before your Works Cited page. Entitle the section Notes
(centered, unformatted).

Formatting the First Page of Your Paper

e Do not make a title page for your paper unless specifically requested.

e Inthe upper left-hand corner of the first page, list your name, your instructor's name, the course, and the date. Again,
be sure to use double-spaced text.

e Double space again and center the title. Do not underline, italicize, or place your title in quotation marks; write the title
in Title Case (standard capitalization), not in all capital letters.

e  Use quotation marks and/or italics when referring to other works in your title, just as you would in your text: Fear and
Loathing in Las Vegas as Morality Play; Human Weariness in "After Apple Picking"

e Double space between the title and the first line of the text.

e Create a header in the upper right-hand corner that includes your last name, followed by a space with a page number;
number all pages consecutively with Arabic numerals (1, 2, 3, 4, etc.), one-half inch from the top and flush with the
right margin. (Note: Your instructor or other readers may ask that you omit last name/page number header on your first
page. Always follow instructor guidelines.)

Here is a sample of the first page of a paper in MLA style:
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http://owl.english.purdue.edu/owl/resource/949/01/

MLA Style Research Paper
based on the 7" ed. of the MLA
Handbook for Writers of Research
Papers. Created Nov 10, 2009.

Your last name,
upper right corner of each page
% inch from top border.

and page # on

Your name

Professor

Course name

Date

Double space
entire paper

Indent 1 inch
from left border

Indent additional
Y inch when
beginning a new
paragraph

Smith 1
John Smith

Professor Williams

Use Times New Roman 12 pt.
or similar easy to read font.

American Studies 104

14 March 2008 Title is centered

Found Voices: Carl Sagan

Carl Sagan was perhaps one of the most influential scientific minds

that the world has ever experienced. When he learned that stars were actually
extremely distant suns, his world was changed and the magnitude of the
universe opened up to him. Another strong motivator into science came with
his reading of a popular science fiction book of the time, The Burroughs
Tales. The stories were not extremely sound scientifically, but still

presented ideals of adventure and the unknown. The idea that life could

Italicize names
of books,
plays, poems,
television
shows,
newspapers,
magazines,
websites,
databases, art,
ships, and
space craft.

exist elsewhere in the universe fascinated Sagan and remained with him for

the rest ofrhis life (Eicher),

In-text citation pointing to a specific source in the works cited list.

Perhapsbe o 8 gan’s most famousidi vidual accomplishments
was his involvement with the Pioneer 10 Space Probe. The probe was created
to be the first object to exit our galaxy. Sagan acknowledged that the chances
of anything actually discovering the probe were astronomical, but believed

that it was important to promote public appreciation for science and thought

the p ojecetoh “alli @d fn  (McDonough 50).

Citation with page number of quotation.

Public appreciation for science was, in fact, what made Sagan the

“superstar scientibt” ta tee hfar o tda y. Hs ability t portray complex
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Your name, page # on upper
right corner of each page %2
inch from top border.

Leave a 1 inch margin from top of paper Smith 2

science as attainable was what made him such a sensational figure. The
greatest example of this was his Cosmos Series. In this thirteen part television
series Sagan presented and explained a large variety of scientific topics ranging
from the origin of life to our place in the universe. It was the most watched
series in the United States for ten years after its release in 1980 (Cohen).
Another work of his similar to Cosmos was his book Pale Blue Dot.
In the book Sagan instills a sense of perspeative and wnde rito man’s
position in the universe (Carl Sagan - Pale Blue Dot). This is one of the most
widely known works by Sagan and many believe it to be his greatest work.
Along with this interest and promotion of science, Sagan also tried to
push people away from pseudo science. His work in exobiology made it
inevitable that he would eventually have to address the growing belief in

UFOs that was so prevalent in the 60s era. Sagan investigated and

acknowledged extraordinary claims but remained extremely skeptical in his
approach. He believed that investigating and disproving popular paranormal
claims would raise scientific awareness (Morrison, Sagan 30).

Sagan was a strong proponent of ending the arms race. This may have
been motivated in part by his study of exobiology. While considering the
probability of other life in the universe he surmised that industrial societies

would bring about their own extinction rather quickly (Morrison, Carl 57).

When there
are two
different
sources by
one author,
in the in-text
citation
provide
additional
information
to direct the
reader to the
correct
source.

Leave a 1 inch margin from bottom of paper
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Smith 3
Some 0 Sdgan’siea swerent & i cly dspl ayed. h 171 Sagan
published an essay considering the use of marijuana under the pseudonym of
Mr. X. He had had experience with the drug, and claimed that it had provided
him with valuable life experience. He summarized his opinion by saying:

When cannabis is legalized, | hope to see this ratio as one of the

If a quotation runs more | parameters printed on the pack. | hope that time isn't too distant;
than 4 lines indent an

additional 'z inch with the illegality of cannabis is outrageous, an impediment to full
no quotation marks.

utilization of a drug which helps produce the serenity and insight,
sensitivity and fellowship so desperately needed in this
increasingly mad and dangerous world (Sagan).

All of these ideas and opinions together constitute a consistent
message. Sagan was an example of what a scientist and intellectual should
be. He was a rational, skeptical and curious individual whose voice is severely
underrepresented in all aspects of culture and life today. His work in promoting
scientific literacy has had lasting affects and contributed greatly to the collective
human knowledge. He will be remembered as an intelligent and thoughtful

scientist and human being.
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Arrange sources alphabetically
by te authoa’s Ist me
no author, by the first word in

the citation.

MLA Style Works Cited

,0 if

Your last name, and page # on
upper right corner of each page
% inch from top border.

Include the
medium of each
source: print,
web, CD, DVD,
television,
radio, film, e-
mail, film,
performance
etc.

Indent each
source 1 inch
from border,
double space,
and indent
second and
consecutive
lines.
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online
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RESUME WRITING

A resume is a summary of your experiences and skills relevant to the field of work you are entering. It highlights your
accomplishments to show a potential employer that you are qualified for the work you want. It is not a biography of
everything you had done. Its purpose is to get you an interview.

OVERVIEW
*A resume is a summary of your experiences and skills relevant to the field of work you are entering.

*It highlights your accomplishments to show a potential employer that you are qualified for the work you want. It is
not a biography of everything you have done.

*[ts purpose is to get you an interview.

*A resume can (and often should) reflect more than just your paid work experience. Current students, in particular,
should consider including the details of your more important extracurricular, volunteer and leadership experiences.

*Tailor separate resumes to fit each career field in which you are job searching. Some people create slightly different
resumes tailored to each job opening.

*Remember that you can attend a resume workshop or have your resume critiqued here at the Career Center.
STEP 1 - Make a list of your various activities over the years.

+Student should list paid work, volunteer positions, extracurricular activities, (especially those in which you had a
leadership role) and internships.

*Students should go as far back as four or five years. Even graduating seniors will often have one or, occasionally,
two items from high school on their resume. However, they may also so many experiences from college that they
may not need to include experiences from high school.

*Alumni may also list volunteer, leadership and civic activities, especially those in which you had a leadership role or
those that indicate skills relevant to the career field you are pursuing.

STEP 2 - Write a paragraph about each important item in your list.

"Important items" would include most paid work, internships, extended volunteer activities, and activities in which
you had a leadership role.

*Don't worry about the wording of your paragraphs at this point - for now, they don't need to fit the standard
"resume language."

*Describe accomplishments as well as duties. An example of a duty might be "I maintained ten computers, loading
new software and resolving problems as needed," while an example of an accomplishment might be "I created two
self-paced Powerpoint presentations to train people in our office on the new company software, and it was so
successful that my manager asked me to present it to five other managers in the company."

NOTE: You will eventually change your wording into "resume language,” dropping any "I's" and making your phrases
more concise. For now, use whatever language you want.

STEP 3 - Pick the items that you will highlight or emphasize on your resume.
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Give this some thought! Consider two factors here:
1) What are your greatest strengths, and how can you demonstrate those strengths through your experience?

All employers value certain qualities: team player; good communication skills; leadership abilities. In addition, you
have particular skills that you consider your strong points, you would generally try to bring those to light, as well. (If
you want help understanding your skills, we recommend you speak with a career advisor.)

2) What are the requirements and needs of this particular industry, this particular employer, and this particular job?
Here's an example of the needs of an industry and a job:

Advertising industry - account executive:

sthe industry tends to value creativity, high energy, and the ability to work in a hectic, deadline-driven environment.

sthe job of account executive demands that you be detail-oriented, good with people, and able to handle many
projects at once.

Your task, then, would be to demonstrate those qualities through the activities described on your resume.
NOTE: You may want to create somewhat different resumes for different jobs.
STEP 4 - Create the sections of your resume.

NOTE: What follows is the format for a chronological resume, by far the most common form of resume in use
today. Occasionally, alumni who are changing careers or re-entering the work force after a prolonged absence may
find that a functional resume is more appropriate. Visit our sample resumes to see examples of both styles.

*Name and Address

*Objective / Keywords / Summary
*Education

*Experience

*Activities / Volunteer Work / Interests
+Skills

*References

Name and Address

*Put your name in at least 14-point. Recruiters often must look through stacks of resumes in search of a particular
one. Make it easy for them to see your name.

*If you are still in school, be sure to include both your school address and phone number, as well as the address and
phone number where you can be reached during school vacations or after you graduate.

Include your e-mail address. If you check your e-mail during school vacations, you may want to center the address
on your resume in a way that implies it is not just associated with your school address. Be sure to have a
professional email address for your job/internship search. Employers may be turned off by your
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greatguy@gmail.com email address. Also avoid the email hyperlink under your email address. The line under your
email should not be included.

*Avoid unnecessary personal information such as marital status and date of birth.
Obijective / Keywords / Summary

OBJECTIVE: An objective is optional. If you have worked out a clearly targeted job objective, then definitely include
it.

*Avoid pronouns and flowery language.

*Focus on what you have to offer rather than on what the job can offer you. This may sound backwards, but
employers are not so much interested in what you hope to get out of a job with them, so much as they want to know
whether you fit their needs.

*Example: OBJECTIVE: Editorial assistant position in publishing industry, utilizing my academic background in
literature and my three years of experience writing for campus and local newspapers.

If you are not clear on your career goals, you probably should not include an objective on your resume. You should
work with a career advisor to focus you interests and objectives.

If you are applying for an internship, you probably should not include an objective on your resume.
KEYWORDS/SUMMARY

IMPORTANT - Resumes that are sent to an employer by e-mail or that are entered onto a form on the Web may end
up on a resume database. When recruiters seek resumes from these databases, they try to match certain keywords
appropriate to a particular career field.

Particularly for job seekers with experience in that career field, it is important that your resume contain some of
those keywords. Click here to learn more about resume keywords.

Experienced job seekers, especially those with two-page resumes, sometimes include a Summary of Qualifications
section at the beginning of their resume. IF you choose to include a Summary, it should be concrete (e.g. "five years
management experience in the health care industry,"” etc.), and it should include as many appropriate keywords as
possible.

Education
*This section always goes first on your resume, as long as you are in school.

*If you are still an undergraduate and applying for an internship, list your high school below Boston College in this
section (freshmen and sophomore students).

NOTE: Your significant activities from high school can be listed in this section, though many students benefit more
from listing those in more detail in their Experience or Activities sections.

*If you have graduated from college, your education section goes first on your resume from one to three years after
you graduate, depending on such factors as whether your education was relevant to your career field and how
impressive your work experience has been in the intervening years. If you have recently received a graduate or
professional degree, your education would usually go at the top of your resume.
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*As a graduating senior, your GPA should always be mentioned, as long as it is above 3.0. Most recruiters will
assume that it is below 3.0 if they do not see it on your resume. (The phrase "3.2/4.0" indicates that you have a 3.2
GPA on a scale that runs up to 4.0. Some schools use a 5.0 scale.) Your GPA is printed on your most recent BC
transcript. Do not round up your GPA. If you have a 3.90, put that down. Do not round up to a 4.00. Employers
want to see accurate information and may compare your resume GPA with your official transcript.

*"Courses studied" or "Relevant Coursework" is an optional section. If you have taken courses outside your major
that are relevant to the job (or if you simply want to emphasize your academic training relevant to the job or
internship), you would definitely benefit from including this section. For example, if you were a Philosophy major
trying to find work in the computer industry, and you had taken three courses in the Computer Science department,
you would definitely include them in a "Relevant Courses" section."

+Significant honors and awards can be included as a sub-category of your Education section.

Experience

What should you include in this section?

*Don't feel that you must limit this section to paid work experiences, especially if you are still in college or a recent
graduate. Employers understand that the most valuable or most challenging experiences often occur in internships,
volunteer work or other extracurricular activities.

*Nursing Clinical Experience - List placements in reverse chronological order, including dates. Describe type of
setting, responsibilities, and knowledge gained.

Student Teaching Experience - Include name and location of placements, dates involved, and grade level of
assignment. Major responsibilities in teaching area should be emphasized.

IMPORTANT - How should you describe your experiences?

*Consult the paragraphs you wrote about each of your jobs or activities - choose from one to eight sentences
(depending on the extent of your responsibilities) that encapsulate the skills you used at this job or activity, your
duties and your significant accomplishments.

eInclude both your duties AND your accomplishments.

Duties tell the employer you can do the job. Accomplishments indicate that you will go above and beyond the call of
duty:

Duties alone can sound bland: "Wrote articles, researched topics, filed documents"?

*When you add your accomplishments and contributions, you set yourself apart from the other applicants --
"Researched and wrote weekly Music Notes for local arts newspaper. Created archival database that saved staff
several hours of work per week. Chosen from among seven interns to represent newspaper at MusicFest 2001
festival; wrote feature story that ran on front page.”

*Use action verbs ("wrote," "managed," "researched," "coached," "planned," etc.).

*Where possible, use keywords - Resumes that are sent to an employer by e-mail or that are entered onto a form on
the Web may end up on a resume database. When recruiters seek resumes from these databases, they try to match
certain keywords appropriate to a particular career field.
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Particularly for job seekers with experience in that career field, it is important that your resume contain some of
those keywords.

*Cite numbers to make a point (e.g. number of people supervised, number of children in classroom; size of event;
budget you oversaw, etc.)

*Be concise. Avoid use of the pronoun "I".
Include "buzz" words only if you are sure of their meaning.

Activities / Volunteer Work / Interests

*If you choose to separate your work experience from your extracurricular activities or volunteer work, they can go
in a separate section. BUT they don't have to go in a separate section. REMEMBER, though, that some of these
activities may demonstrate your skills just as well or even better than your paid work experience.

*You do not need to demote these activities to the bottom of your resume. Employers spend an average of 15 -30
seconds looking at each resume. What's left at the bottom of your resume may not get any attention.

*A note about "interests": listing your "interests" or hobbies on a resume is okay, but generally you should not do so
at the expense of leaving out other, more important information. When should you list your interests?

e when your interests or hobbies are so unusual that they are bound to attract positive attention. (One recent
alumna, applying for work in the investment industry, listed "sky diving" as a hobby. Every recruiter that
interviewed her started the interview off with a question about her hobby.)

e when your interests or hobbies reflect positively on your job skills. For example, if you are applying for
work as a paralegal and you love chess, the recruiter may equate your hobby with analytical abilities.

Skills

This is an optional section - if specific skills are necessary to the job, or if your skills help you stand out from the
crowd, then include a skills section in your resume.

Computer skKills:

*You may wish to list the systems (Macintosh, IBM, UNIX, etc.) and applications (Filemaker Pro, Microsoft Word,
Pagemaker, HTML, Excel, Powerpoint, etc.) with which you are capable.

*If you know programming languages, list those as well.
*You may even want to use italicized sub-categories:
Languages:

+List languages in which you have more than just some basic ability. In other words, if you are able to carry on a
conversation in that language, list it.

*Indicate your level of ability ("basic conversational ability, near-fluency," "fluency") or the number

of years of college-level study.

proficiency,

Laboratory skills:
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*If you are applying for scientific or laboratory positions, you may want to create a list of your lab skills. A biology
major might break those skills down into sub-categories such as "histology," "cell culture," and "staining.” Of
course, the sub-categories and skills mentioned should be relevant to the particular job.

*Always check your skills list with a professor or mentor, unless you have significant professional experience in that
career field.

References
Don't write "References Available On Request” on your resume. This went out of style over a decade ago.
Do create a references list as soon as you can and have it available, in case an employer asks for references.
Click here for more information on creating a list of references.

STEP 5 - Format your resume.

THE KEY to a well-formatted resume - realize that most employers will only spend 20-30 seconds looking at your
resume. You direct the employer's eye to the most important information:

1.Leave plenty of white space on your resume - don't make your resume look crowded.

2.Emphasize job titles by boldfacing them (except where the name of a prestigious organization you have worked
for will grab their attention first).

3.Place the most important information closer to the top of your resume. (For example, if you are a student and your
paid work has been fairly mundane, but you have great computer skills or excellent extracurricular leadership
experience, then put the skills or the extracurriculars near the top of your resume.)

4.Where appropriate, descriptive category headings can attract an employers attention (for example, "Counseling
and Tutoring Experience" or "Leadership Experience" instead of just "Experience™).

5.Leave blank space between the separate sections and items on your resume.
Other formatting details:
*Condense to one page.

Exceptions: two-page resumes for nursing, for education and for those alumni who have over two years of
experience in that field (however, before going with a two-page resume, check with others in your career field).
Alumni with many years of experience in a broad range of jobs may be interested to look at When a Lengthy
Resume Makes Sense for Executives (will open a new browser window).

Center and balance your resume on the page, leaving approximately 1 inch margins.
*Design your resume for easy skimming: emphasize by boldfacing, capitalizing and italicizing.
*Use 8 1/2" x 11" white, off-white or very light-gray bond paper. Do not use colored paper.

*Proofread carefully and have a Career Center staff member review your final draft.
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SAMPLE RESUME

Emir A. Liguori | Objective

53 Richmond Ave
Paterson, New Jersey 07502 To acquire a challenging position where my skills can be utilized to their full potential with

973-896-8471 | opportunities for advancement.
eliguori@paterson.k12.nj.us

liquori72@msn.com
aliguori@fdu.edu

Areas of Expertise

Upper Management Human Resources, Customer Care, Technical Support.

Draft and analyze terms and conditions, ensure contractual

Contract & Agreements obligations are fulfilled, renewals and extensions.

Create and manage plan of work, market studies and

Project Supervision
research.

Procurement and provisioning, negotiating, billing audits and

Vendor Interaction . PR
service modifications.

Primary point of contact, facilitate presentations to clients,

Client Relations
sales support.

Classroom and Remote Learning Plans, Trained Customer
Teaching & Facilitating | Care, Technical Support and Virtual Private Networks staffs.
Reporting -Cost Analysis.

Work Experience

Professor, Fairleigh Dickenson University, Teaneck, NJ
4/2010 — Present
= Prepare course materials such as syllabi, homework assignments, and handouts

= Prepare and deliver lectures to undergraduate and/or graduate students on topics such as poetry,
novel structure, and translation and adaptation.

= Plan, evaluate, and revise curricula, course content, and course materials and methods of
instruction.

= Evaluate and grade students' class work, assignments, and papers.
= Maintain student attendance records, grades, and other required records.
=  Compile, administer, and grade examinations, or assign this work to others.

= Collaborate with colleagues to address teaching and research issues

Fleet Manager, Paterson Board of Education, Paterson, NJ
5/2005 - Present
= Plan routes for special education and regular student transportation to & from 56 district schools.
= |Implement District owned vehicle procedures for the to manage over 70 vehicles and 120 drivers.
= Responsible for all vendor relations, including negotiation of prices, bidding, quotes and RFPs.

= Draft contracts for maintenance and repair services, auto body repairs and award contract to
lowest bidder.

= Manage fleet budget for fueling, vehicle maintenance and vehicle insurance and other specialized
vendors.

= Supervise all maintenance and repairs of the entire district fleet and manage all gas accounts for the
fleet, insurance contracts for the district owned vehicles.

= Manage driver license requirements and records and review abstracts periodically.
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Maintain database for maintenance and repairs and gas usage of all district owned vehicles.

Responsible for all NJ DMV transactions.

Sr. Purchasing Analyst, Paterson Board of Education, Paterson, NJ
7/2003 - 5/2005

Write and publish bids and RFPs for services and equipment needs of the Paterson School District.
Analyze bidder’s bids and RFPs and create actions to award contract to the lowest bidder.
Negotiate vendor rates and prices and submit final cost report to the Supervisor of Purchasing.
Responsible for the management of vendor contractual obligations.

Processing of daily purchase orders and analysis of daily un-approved.

Researching vendor price increases as they pertain to State Contract and rate vendors.

Research Bid Compliance and determination of the need for open public bidding.

Analysis of outstanding purchase order report on a continuous basis to ensure prompt vendor
payment.

Assistance to departments on proper requisitioning procedures.

Project Manager, Tyco International, Morristown, NJ
4/2001 - 10/2002

Manage all TGN and Non- TGN project from concept to closeout.
Create and manage OA&M Plans of Work for TGN and Non-TGN Systems.

Manage Non- TGN OA&M lease contracts, cost models and sub-contracts and be the main
customer interface.

Manage the contract of all TGN and Non- TGN systems pertaining to Operation Administration and
Management.

Coordinate all permits and leases are acquired simultaneously for the civil build.

Ensure all terms and conditions for potential leases are reviewed and all lease issues are addressed.

Manage budget and equipment deployment for Cable Station and Tel-Exchanges.
Monitor civil design requirements to assure our project deadlines are met.
Review lease agreement concerning unique site requirements for Co-Location.

Coordinate station staff hiring and training for proper testing of site acceptance diversity routing as
well.

Interfere with resources allocation by functional area if proper judgment not applied.

5/1996 William Paterson University, Wayne, New Jersey

* Bachelor’'s Degree - Business Marketing

5/2015 Fairleigh Dickenson University, Teaneck, New Jersey

= Master’s Degree Candidate May 2016 - Administrative Science

Skills

Customer Service Excellence certified.

Bilingual/Bicultural, English Spanish.

Infinite Campus, Edumet, Alio, Fusion, Kronos, Transfinder, Docs Open, Lotus Notes, MS Project, MS
Windows, Oracle Financial, Visio 4.0.
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SAMPLE COVER LETTER

Yulia Ocampo
29 Mary Street, Dover NJ 07801
(862)555-1574
jhoanm@hotmail.com

To whom it may concern,

Enclosed is a copy of my resume for your consideration, which briefly outlines my accomplishments and work experience
during the past years at Queens Limo, Wal-Mart and Christophe and Associates, P.C. listed in this resume are
gualifications that certainly apply to this position, which are presented in a limited manner.

The experiences | posses cover all areas of management, customer service, human resources, accounting and much more
as my resume indicates, | also posses experience supervising small groups such as customer service, prepared immigration
and court documents. Finally, my work habits and communications skills are exemplary my desire and willingness to
create a positive teamwork environment and exceed expectations are a direct result of my professional growth with
previous employers.

Should my qualifications meet your needs in this field, | would be happy to discuss my background in greater depth.

Thank you for your time and consideration | hope to hear from you at your earliest convenience.

Sincerely,

Yulia Ocampo
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EMAIL WRITING

If you work in an office, you probably write emails every day — to colleagues, to your boss, to clients. Even if you’re
still at college, you’ll need to email your lecturers once in a while (maybe to plead for an essay extension, or to ask for
help) — and many employers now expect resumes and cover letters to be sent by email.

So, being able to write a professional, business-like email is a crucial skill. Daily Writing Tips has already covered the
email subject line, but the body of your message also matters.

1. Start with a salutation

Your email should open by addressing the person you’re writing to. Sure, you can get away with leaving out the
salutation when you’re dashing off an email to your friend, but business-like messages should begin with:

e Dear Mr Jones, or Dear Professor Smith, (for someone you don’t know well, especially if they’re a superior)

e Dear Joe, or Dear Mandy, (if you have a working relationship with the person)

It’s fine to use “Hi Joe”, “Hello Joe” or just the name followed by a comma (“Joe,”) if you know the person well —
writing “Dear Joe” to one of your team-mates will look odd!

2. Write in short paragraphs

Get straight to the point — don’t waste time waffling. Split your email into two to four short paragraphs, each one dealing
with a single idea. Consider using bullet-points for extra clarity, perhaps if you are:

e Listing several questions for the recipient to answer

e Suggesting a number of alternative options

e Explaining the steps that you’ll be carrying out

Put a double line break, rather than an indent (tab), between paragraphs.

3. Stick to one topic

If you need to write to someone about several different issues (for example, if you’re giving your boss an update on
Project X, asking him for a review meeting to discuss a payrise, and telling him that you’ve got a doctor’s appointment
on Friday), then don’t put them all in the same email. It’s hard for people to keep track of different email threads
and conversations if topics are jumbled up.

4. Use capitals appropriately

Emails should follow the same rules of punctuation as other writing. Capitals are often misused. In particular, you
should:

o Never write a whole sentence (or worse, a whole email) in capitals

e Always capitalise “T” and the first letter of proper nouns (names)

o Capitalise acronymns (USA, BBC, RSPCA)

o Always start sentences with a capital letter.

This makes your email easier to read: try retyping one of the emails you’ve received in ALL CAPS or all lower case, and
see how much harder it is to follow!

26


http://www.dailywritingtips.com/pay-attention-to-the-email-subject/

5. Sign off the email

For short internal company emails, you can get away with just putting a double space after your last paragraph then
typing your name. If you’re writing a more formal email, though, it’s essential to close it appropriately.

Use Yours sincerely, (when you know the name of your addressee) and Yours faithfully, (when you’ve addressed it to
“Dear Sir/Madam”) for very formal emails such as job applications.

Use Best regards, or Kind regards, in most other situations.

Even when writing to people you know well, it’s polite to sign off with something such as “All the best,” “Take
care,” or “Have a nice day,” before typing your name.

6. Use a sensible email signature

Hopefully this is common sense — but don’t cram your email signature with quotes from your favourite TV show,
motivational speaker or witty friend. Do include your name, email address, telephone number and postal address (where
appropriate) — obviously, your company may have some guidelines on these.

It makes it easy for your correspondents to find your contact details: they don’t need to root through for the first message
you sent them, but can just look in the footer of any of your emails.

Putting it all together

Compare the following two job applications. The content of the emails are identical — but who would you give
the job to?

I’ve attached my resume i would be grateful if you could read it and get back to me at your earliest convenience.
i have all the experience you are looking for — i’ve worked in a customer-facing environment for three years, i
am competent with ms office and i enjoy working as part of a team. thanks for your time

Or
Dear Sir/Madam,

I’ve attached my resume. I would be grateful if you could read it and get back to me at your earliest
convenience. | have all the experience you are looking for:

e T’ve worked in a customer-facing environment for three years
e | am competent with MS office
e | enjoy working as part of a team

Thanks for your time.
Yours faithfully,

Joe Bloggs

Sometimes we want to be direct and brief in our emails (giving status updates, summarizing meeting minutes, describing
technical issues, etc.). Other times, we want to be polite and indirect. The chart below provides examples of situations
in which we normally write in an indirect, polite way.
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Situations

Language

Notes

Simple Requests

(the reader has an
obligation to comply with
your request)

Asking an employee or
coworker to do
something that he/she
normally handles

Could/can
you...please?

Would you mind...?

“Would you mind * is a bit more
polite than “can/could

you...?” Also, “could” is a little
more polite than “can.” Remember
that “mind” is followed by the
gerund (ing). For example, “Would
you mind taking te-take a look at
this.”

Favors and Big Requests

(the reader does not have
an obligation to comply
with your request)

Getting help with
something that you
normally handle yourself

“Special” requests

I was hoping you
could...

I was wondering if you
could...

Do you think you might
be able to...?

Favors and big requests require
“softer” language. One way to
make language softer is by using
past tenses (“l was hoping,” “I was
wondering,” “l wanted to,”

etc.) Another way we make
language softer is by using modals
(“might,” “could,” etc.).

Permission

Vacation requests
Time off requests

Borrowing something

I was hoping I could...

I was wondering if |
could...

Would it be okay if
I...2

Do you think I might
be able to...?

Just like with favors and big
requests, we use softer language to
ask for permission (past tenses,
modals, etc.)

Suggestions

Offering your point of
view

Suggesting a better way
of doing something

What about if...?
Maybe we could...?

I thought it might be a
good idea to...

Using these expressions sounds
more polite than “Well, | think we
needto...”

Rejecting/Refusing/Decli
ning

Rejecting
offers, suggestions,

proposals/ideas

I’m not sure that...

I don’t know if...

Using tentative language like “/'m
not sure that...,” and “I don’t know
if” sounds more polite than “that
won’t work.”

Pointing out a Mistake

Billing mistake

It looks like...

It seems...

These introductory statements help
to make the message softer.

Checking on the Status
of Something

Finding out if something
is finished

Gently reminders

Have you had a chance
to finish/work on...?

“Have you had a chance to
finish/work on...” is much more
polite than “Are you finished yet?”
or “Is it ready yet?”
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Language we use to sound more polite:

Modals: might, can, could, would

Distancing phrases (not using the present tense): 1 was hoping..., [ was wondering..., [ wanted to...

Tentative language: Maybe..., Perhaps..., I’'m not sure if..., I don’t know if..., might

Introductory phrases: It looks like..., It seems like..., Actually...,To be honest...Well..., I see what you’re saying
(but...),

Positive language (avoiding negative expressions like “bad,” “won’t work,” “ineffective,” etc.): It might not be the

best approach (NOT “it’s a bad approach”).
Writing Practice

Write emails for the situations below. Be polite and indirect. Use the language in the chart above (modals, distancing
phrases, tentative language, introductory phrases, positive language)

1) You have some suggestions about how to get more business. You want to meet with one of the managers and talk
about this business opportunity. Write a polite email requesting a 30-minute meeting.

2) You have some personal issues you need to take care of on Tuesday morning. You’d like to take Tuesday morning
off and make up the time later in the week. Write a polite email to your supervisor explaining the situation. Ask for
permission to take the time off and make it up later in the week.

3) Your own situation: Are there any situations you regularly deal with that require polite, indirect emails? Think of a
situation and write a polite email.
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BUSINESS LETTERS

Plan before you write.
Look up words you need before you start.
Note the points you want to make, and order them into logical paragraphs.

Tone
Write as you would speak in a business conversation. The tone should be friendly and polite.

Names

Make sure you check the gender of the addressee (the recipient), as well as the correct spelling of the person's name
and title.

Use Ms. for women and Mr. for men. You can use Mrs. for a woman if you are 100% sure that she is married.

Dates
To avoid any confusion, write the month instead of using numbers (e.g. January 15th, 2012 or 15 January 2012).

Be concise and clear. The easier it is to read a letter the better.

Keep sentences and paragraphs short and simple.

Use straightforward vocabulary to avoid any misunderstanding.

Ask direct questions.

Rewrite any sentence that does not seem perfectly clear.

If the recipient is not a native English-speaker, it is preferable to avoid  words or expressions that are too technical or
complicated.

Remember this word order principle
Subject Verb Object Manner Place Time
Who Does What How Where When

Example: Mr. Brown will travel by plane to London on Monday, June 5th. A technician will install the equipment in
your office on Tuesday.

Avoid old-fashioned words

Although they are used in legal documents and contracts, words like 'herewith’, 'herein’, ‘'aforementioned’, etc. are
rarely used in letters. ~ The following style of sentence is preferable : "You will find more information on our
products in the enclosed brochure.”

Whatever you do — whether you’re a student, employed in an office job, or working as a freelancer — | can guarantee that
at some point in your life, you’ll need to sit down and write a formal business letter.

It might be to a customer, to an employer with a job that you want, or to apply for university funding. Perhaps it’ll even
be to a literary agent or publisher who just might take on your undiscovered novel. Of course, you’ll want the letter to be
well-written — but almost as important is knowing how to format it correctly. This article is about US business letter
format (for UK readers, don’t worry, I’1l be writing a follow-up one for you.)

The main formats for business letters in the US are called full block format and modified block format.
o Full block format means that all the elements of the letter are left-justified so that the start of each line is at the left-
hand margin. This is the more formal style, so use it if you’re unsure which to go for.
o Modified block format means that some elements of the letter are shifted over to the right. Nowadays, this style is
appropriate in most contexts.

Samples found at: https://www.uww.edu/Documents/aso/formatting.pdf
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Here’s a full block format letter

Business Letter
Block Style with Open Punctuation

Date — Always type out in full. Begins at least

4‘_____________————————————“““ 5” below the letterhead. For the purpose of

August 24, 2010 this class we will begin at 2.

Address Block — Includes the name, organization,
Ms. Kathryn M. Amsbury ‘//// and address of the person receiving the letter.
Home Care Nursing, P.C. Should appear a QS below the date. One or two
6807 Crestridge Drive spaces are typed after the state abbreviation. We

Hopkins, MN 55343-1921 will use one!

Dear Ms. Amsbury

As you requested, I shall be happy to meet with you on August 30
at 10 a.m. to review your copy needs. I am confident that we
have just the right copier for you.

Please come to my office at our new address, which is shown in
the letterhead above. Bring some figures relating to your
volume of copying as well as information about size and color
needs. After determining your needs, we can then visit our
adjoining showroom so that you can select the model that will be
best for you.

HiTech is dedicated to providing up-to-date office services in

the greater Twin Cities area. Our new, expanded facilities will
help us achieve that goal. I have enclosed a brochure about the
company that may answer any questions you have. _/

Sincerely yours <— Closing

'sydesBesed usamiag SQ e yum SS — Apog

Signature Block — title either next to the name, separated by
4/,,,,,,,,,——”””” a comma or typed below the name as here. Which you use is
David G. Kramer determined by length. Name appears a QS below the

Customer Relations Associate closing

Reference Initials — the initials of the typist
dls & (notthe writer)

Enclosure

sent along with the letter.

Enclosure Notation — included if another item(s) is being

c: Jo?p Smith

Copy Notation — included if a copy of the letter is being sent to
someone other than the stated recipient.

Page 3

31



And a modified block format one:

Business Letters
Modified-Block Style with Mixed Punctuation

August 24, 2010

Ms. Kathryn M. Amsbury
Home Care Nursing, P.C.
6807 Crestridge Drive

Hopkins, MN 55343-1921

Dear Ms. Amsbury:

As you requested, I shall be happy to meet with you on August 30
at 10 a.m. to review your copy needs. I am confident that we
have just the right copier for you.

Please come to my office at our new address, which is shown in
the letterhead above. Bring some figures relating to your
volume of copying as well as information about size and color
needs. After determining your needs, we can then visit our
adjoining showroom so that you can select the model that will be
best for you.

HiTech is dedicated to providing up-to-date office services in
the greater Twin Cities area. Our new, expanded facilities will
help us achieve that goal. I have enclosed a brochure about the

company that may answer any questions you have.

Sincerely yours,

David G. Kramer
Customer Relations Associate

dls
Enclosure

c: John Smith

Page 6
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Memorandums

Memorandums
Simplified Memo in Block Style

Memorandum title — May not be necessary if your company has letterhead for memos. If
Memorandum  <«— |etterhead is used the top margin should be at least 14 below the letterhead. If no
letterhead is used, the top margin should be approximately 1 42 — 2”.

October 18, 2010 «—— Date — Triple space after the Memorandum title —
Quadruple space follows it

Subject line — can be
in all caps or in initial
caps with bold
formatting — followed
by a double space

Receiver of the Memo — double

Curtis Marlowe, Home Designs «— space follows it

TIMBER CREEK SITE <

Some observations seem appropriate now that the laying of wiring and conduits for Phase | of
the Timber Creek site is being finalized. It is my understanding that a high percentage of Timber
Creek residents likely will be first-time home buyers.

Cost will be an important criterion; but on the basis of our previous experience with this type of
development, o her fhctors soul d i ¢ onsidered. Ourandel loes dld re flect today’s
informal life-style. The use of a great room rather than both a family room and a living room is
one way to reduce costs. Also, since both the husband and wife in most homes will work outside
the home, there should be two-car garages. We have also found that many people like the option
of leaving certain areas unfinished; these can be finished later as the family grows and as finance
permit.

I shall be happy to meet with you to discuss these concerns.

Sender of the memo — preceded by a quadruple
space

Doug Nestell, Sales Director

dls€«— Reference Initials — the initials of
the typist

Page 7
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Personal Business Letters — Block Style

. Date — Always
Personal Business Letters type out in full.
. . Top margin varies
Block Style with Open Punctuation depending on the

4__________________________________________———————————— length of the
August 24, 2010 letter. For the

purpose ofrtrhis

Address Block — Includes the name, organization,
Ms. Kathryn M. Amsbury ‘//// and address of the person receiving the letter.

Home Care Nursing, P.C. Should appear a QS below the date. One or two
6807 Crestridge Drive spaces are typed after the state abbreviation. We

Hopkins, MN 55343-1921 will use one!

Dear Ms. Amsbury

As you requested, I shall be happy to meet with you on August 30
at 10 a.m. to review your copy needs. I am confident that we
have just the right copier for you.

Please come to my office at our new address, which is shown in
the letterhead above. Bring some figures relating to your
volume of copying as well as information about size and color
needs. After determining your needs, we can then visit our
adjoining showroom so that you can select the model that will be
best for you.

HiTech is dedicated to providing up-to-date office services in

the greater Twin Cities area. Our new, expanded facilities will
help us achieve that goal. I have enclosed a brochure about the
company that may answer any questions you have. .]

Sincerely yours <— Closing

‘sydesbesed usamiaq SQ e yum ss — Apog

/ Signature Block — Name appears a QS below the closing.
Denise L. Schulz

259 West Ottawa Avenue
Dousman, WI 53118

Enclosure < Enclosure Notation — included if another item(s) is being

sent along with the letter.

Cc: Jo?p Smith

Copy Notation — included if a copy of the letter is being sent to

the person typing the letter is the one
writing it as well.

someone other than the stated recipient. *Note: Reference initials are generally not
keyed on a PBL. The assumption is that
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Personal Business Letter — Modified Style

Personal Business Letters
Modified-Block Style with Mixed Punctuation

259 West Ottawa Avenue
Dousman, WI 53118
August 24, 2010

Ms. Kathryn M. Amsbury
Home Care Nursing, P.C.
6807 Crestridge Drive

Hopkins, MN 55343-1921

Dear Ms. Amsbury:

As you requested, I shall be happy to meet with you on August 30
at 10 a.m. to review your copy needs. I am confident that we
have just the right copier for you.

Please come to my office at our new address, which is shown in
the letterhead above. Bring some figures relating to your
volume of copying as well as information about size and color
needs. After determining your needs, we can then visit our
adjoining showroom so that you can select the model that will be
best for you.

HiTech is dedicated to providing up-to-date office services in
the greater Twin Cities area. Our new, expanded facilities will
help us achieve that goal. I have enclosed a brochure about the
company that may answer any questions you have.

Sincerely yours,
Denise L. Schulz

Enclosure

c: John Smith

Page 9
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BUSINESS LETTER WORDS & PHRASES

Salutation

Starting

Referring to previous
contact

Making a request

Offering help

Giving good news

Giving bad news

e Dear Mr. Brown

* Dear Ms. White

e Dear Sir

e Dear Madam

e Dear Sir or Madam
e Gentlemen

» We are writing

- to inform you that ...

- to confirm ...

- to request ...

- to enquire about ...

* [ am contacting you for the following reason...

* I recently read/heard about ..... and would like to know ....
 Having seen your advertisement in ..., | would like to ...

» [ would be interested in (obtaining / receiving) ...

* [ received your address from ----- and would like to ...

*» Thank you for your letter of March 15.

* Thank you for contacting us.

* In reply to your request, ...

* Thank you for your letter regarding ...

» With reference to our telephone conversation yesterday...
* Further to our meeting last week ...

* It was a pleasure meeting you in London last month.

« I enjoyed having lunch with you last week in Tokyo.

* [ would just like to confirm the main points we discussed
on Tuesday.

* We would appreciate it if you would ...

* [ would be grateful if you could ...

* Could you please send me ...

* Could you possibly tell us / let us have ...

* In addition, I would like to receive ...

* It would be helpful if you could send us ...

* [ am interested in (obtaining / receiving) ...

* | would appreciate your immediate attention to this matter.
* Please let me know what action you propose to take.

* Would you like us to ...?

* We would be happy to ...

* We are quite willing to ...

* Our company would be pleased to ...

* We are pleased to announce that ...
* I am delighted to inform you that ..
* You will be pleased to learn that ...

* We regret to inform you that ...

* I'm afraid it would not be possible to ...

* Unfortunately we cannot / we are unable to ...

* After careful consideration we have decided (not) to ...
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Complaining

Apologising
(US: Apologizing)

Orders

Prices

Referring to payment

Enclosing documents

Closing remarks

Referring to future business

Referring to future contact

* [ am writing to express my dissatisfaction with ...
* [ am writing to complain about ...
* Please note that the goods we ordered on ( date )

have not yet arrived.

* We regret to inform you that our order n° ----- is now

considerably overdue.

* I would like to query the transport charges which seem

unusually high.

We are sorry for the delay in replying to ...

I regret any inconvenience caused (by) ...

I would like to apologise for the (delay, inconvenience)...

Once again, please accept my apologies for ...

Thank you for your quotation of ...

We are pleased to place an order with your company for..

We would like to cancel our order n° .....

Please confirm receipt of our order.

I am pleased to acknowledge receipt of your order n° .....

Your order will be processed as quickly as possible.

It will take about (two/three) weeks to process your order.

We can guarantee you delivery before ...(date)

Unfortunately these articles are no longer available /  are out of stock.
Please send us your price list.

You will find enclosed our most recent catalogue and price list.
Please note that our prices are subject to change without notice.
We have pleasure in enclosing a detailed quotation.

We can make you a firm offer of ...

Our terms of payment are as follows ...

Our records show that we have not yet received payment of ...
According to our records ...

Please send payment as soon as possible.

You will receive a credit note for the sum of ...

I am enclosing ...

Please find enclosed ...

You will find enclosed ...

If we can be of any further assistance, please let us know.

If I can help in any way, please do not hesitate to contact me.
If you require more information ...

For further details ...

Thank you for taking this into consideration.

Thank you for your help.

We hope you are happy with this arrangement.

We hope you can settle this matter to our satisfaction.

We look forward to a successful working relationship in the future.
We would be (very) pleased to do business with your company.
I would be happy to have an opportunity to work with  your firm.
I look forward to seeing you next week.

Looking forward to hearing from you, ...

Looking forward to receiving your comments,

I look forward to meeting you on the (date).

I would appreciate a reply at your earliest convenience.

An early reply would be appreciated.

Let’s break those down into the main elements, in top-to-bottom order:
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Your Address

Your address, also known as the “return address”, should come first. (Note that this applies when using standard plain
paper. If you have letter headed paper, you should omit this.)
123 Acacia Avenue
Newtown
Anywhere
AN 98765
Your return address should be positioned:
e On the left-hand side if you’re using full block format
e On the right-hand side (tab across, rather than right-aligning) if you’re using modified block format

Why put your address? Even if the recipient has your details in their address book, you want it to be as hassle-free as
possible for them to reply — you’re likely to receive a speedier response.

The Date

Directly beneath your address, put the date on which the letter was written:

May 15, 2008

To avoid any confusion, especially if you are writing to a business abroad, it is best to put the date in word rather than
number form, and you should omit the “th”.

The date should be positioned on the left-hand side, for full block format and for modified block format

Why put the date? It’s standard practice to include the date on which the letter was written. Correspondence is often
filed in date order. It makes it much easier for the recipient to send a timely reply, and easier for you to chase up an
answer if necessary. Eg. “In my letter of May 15...”

Reference Line

I’ve not included this on the diagram as guidance varies on where it should be placed. You may include a reference line,
starting with “Re:” This is often used when corresponding with large companies, or when applying for a job. The
reference line can either appear beneath the date, OR beneath the recipient’s address.

If you use a reference line, you should usually omit the subject line (see below).

The reference line should be left-aligned for both full and modified block formats.

Why put a reference line? You should use a reference line if the recipient has requested specific information, such as a
job number or invoice number, or if you’re replying to a letter. This makes it easier for the recipient to get a speedy
response to you.

Recipient’s Name and Address

Beneath this, you should put the name and address of the person you’re writing to, just as it would appear on the
envelope. If you’re using a window envelope, this should be aligned on the page to show through the window — but even
if it won’t be visible until the letter is opened, it should still be included.

The recipient’s name and address should be positioned on the left-hand side, for both formats.

Why put their address? If you’re writing to someone in an office, it probably won’t be them who opens the post. An
administrator is likely to do so — and letters may be separated from their envelopes at this stage. Particularly if there are
multiple departments within one building, or if you are starting your letter “Dear Bob”, a name and address ensures your
letter reaches the correct recipient.
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The Greeting

After their address, you should leave a line’s space then put “Dear Mr Jones”, “Dear Bob” or “Dear Sir/Madam” as
appropriate. Follow this with a colon.
The greeting, sometimes called the “salutation”, should always be left-aligned.

Why put a greeting? Business letters are a formal type of writing, and it’s considered polite to start with a greeting.
Although you can get away with starting emails “Hi” or “Hello”, letters follow more conservative conventions.

The Subject

Optionally, you may wish to include a subject for your letter. This is becoming more common, perhaps as people have
become used to the subject lines of emails. If you do put a subject line, it should be in uppercase, directly below the
“Dear name:”

The subject (if you include one) should be left-aligned for full block format, but can be either left aligned or centred for
modified block format.

Why put the subject? It’s a good idea to include a subject so that the recipient can see at a glance what the letter refers

to. Try to be succinct but include as much information as possible, eg. “Funding application from Joe Bloggs, candidate
222-456".

The Text of Your Letter

Now, finally, you can write the main body of your letter. Your text should have:

o Single-spacing between lines

e Anblank line (NOT an indent) before each new paragraph
(And, of course, you should conform to all the usual rules of grammar, punctuation and spelling: for example, ensuring
that you start each sentence with a capital letter, and finish with a full stop.)

Why leave blank lines? In the business world, it’s standard practise to put a blank line between paragraphs. This helps
to break up the text on the page and make it more readable.

The Closing

After the body of text, your letter should end with an appropriate closing phrase and a comma. The safest option is
“Yours faithfully” (when you don’t know the name of the person to whom you are writing, ie. when you began “Dear
Sir/Madam”) or “Yours sincerely” (when you do know their name). If you are already acquainted with the recipient, it
may be appropriate to use a phrase such as “Best regards”, “With warmest regards”, or “Kind regards”.
The closing should be:

o Left-aligned for full block format

e On the right (tab across so it matches up with your address) for modified block format

Why use these phrases? Although “Yours sincerely”” and “Yours faithfully” might sound archaic, they are time-
honoured ways to close a formal letter.

Your Name and Signature

Put several blank lines after the “Yours sincerely,” or “Yours faithfully,” then type your name. You can optionally put
your job title and company name on the line beneath this.
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Joe Bloggs
Marketing Director, BizSolutions

Your name and signature should be:
e Left-aligned for full block format
e On the right (tab across so it matches up with your address) for modified block format

Why leave a blank space? The blank space is so that, when you’ve printed the letter, you can sign it with your name.
This is taken as proof that the letter really is from the person whose name is typed at the bottom. Sometimes, another
person may sign the letter on your behalf. If this is the case, they should put the letters “p.p.” before their name, which
stands for the Latin per procurationem meaning “by agency”.

TRANSITIONAL WORDS & PHRASES

These words and phrases helps papers read more smoothly, and at the same time allows the reader to flow more
smoothly from one point to the next. Transitions enhance logical organization and understandability and improve the
connections between thoughts. They indicate relations, whether within a sentence, paragraph, or paper. This list
illustrates categories of "relationships"” between ideas, followed by words and phrases that can make the connections:

Addition:
also, again, as well as, besides, coupled with, furthermore, in addition, likewise, moreover, similarly

When there is a trusting relationship coupled with positive reinforcement, the partners will be able to overcome difficult
situations.

Consequence:
accordingly, as a result, consequently, for this reason, for this purpose, hence, otherwise, so then, subsequently,
therefore, thus, thereupon, wherefore

Highway traffic came to a stop as a result of an accident that morning.
Contrast and Comparison:
contrast, by the same token, conversely, instead, likewise, on one hand, on the other hand, on the contrary, rather,

similarly, yet, but, however, still, nevertheless, in contrast

The children were very happy. On the other hand, and perhaps more importantly, their parents were very proactive in
providing good care.

Direction:
here, there, over there, beyond, nearly, opposite, under, above, to the left, to the right, in the distance.

She scanned the horizon for any sign though in the distance she could not see the surprise coming her way.

Diversion:
by the way, incidentally

He stumbled upon the nesting pair incidentally found only on this hill.

Emphasis
above all, chiefly, with attention to, especially, particularly, singularly

The Quakers gathered each month with attention to deciding the business of their Meeting.
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Exception:
aside from, barring, beside, except, excepting, excluding, exclusive of, other than, outside of, save

Consensus was arrived at by all of the members exclusive of those who could not vote.
Exemplifying:

chiefly, especially, for instance, in particular, markedly, namely,

particularly, including, specifically, such as

Some friends and | drove up the beautiful coast chiefly to avoid the heat island of the city.

Generalizing:
as a rule, as usual, for the most part, generally, generally speaking, ordinarily, usually

There were a few very talented artists in the class, but for the most part the students only wanted to avoid the alternative
course.

Hlustration:
for example, for instance, for one thing, as an illustration,
illustrated with, as an example, in this case

The chapter provided complex sequences and examples illustrated with a very simple schematic diagram.

Similarity:
comparatively, coupled with, correspondingly, identically, likewise, similar, moreover, together with

The research was presented in a very dry style though was coupled with examples that made the audience tear up.

Restatement:
in essence, in other words, namely, that is, that is to say, in short, in brief, to put it differently

In their advertising business, saying things directly was not the rule. That is to say, they tried to convey the message
subtly though with creativity.

Sequence:

at first, first of all, to begin with, in the first place, at the same time, for now, for the time being, the next step, in time, in
turn, later on, meanwhile, next, then, soon, the meantime, later, while, earlier, simultaneously, afterward, in conclusion,
with this in mind,

The music had a very retro sound but at the same time incorporated a complex modern rhythm.
Summarizing:
after all, all in all, all things considered, briefly, by and large, in any case, in any event, in brief, in conclusion, on the

whole, in short, in summary, in the final analysis, in the long run, on balance, to sum up, to summarize, finally

She didn't seem willing to sell the car this week, but in any case | don't get paid until the end of the month.
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BUSINESS & CORPORATE LANGUAGE

Business English Resources: http://www.businessenglishresources.com/31-2/student-section/business-vocabulary/most-
common-business-idioms/

IDIOM

2417

a tough break

ahead of the curve

ahead of the pack

ASAP

at stake

back to square one

back to the drawing
board

backroom deal

ballpark number

behind someone's

WHAT IT MEANS

"24/7" means 24 hours a day,
seven days a week.

When something unfortunate
happens, it can be called a "tough
break."

To be "ahead of the curve" means
to be more advanced than the
competition.

To be "ahead of the pack" means
to be better or more successful
than the competition.

"ASAP" is an acronym for "as
soon as possible."

"At stake" means at risk.

To go "back to square one" means
to start something over again.

To go "back to the drawing board"
means to start something over
again and go back to the planning
stage of something.

A "backroom deal" is an
agreement or decision that is made
without the public knowing about
it.

A "ballpark number" is a very
inexact estimate.

To do something "behind

EXAMPLES

The convenience store on the corner is open 24/7.

It was a tough break for us when Caroline quit. She was
one of our top performers.

We're investing a lot of money in research and
development so we can stay ahead of the curve.

If we want to stay ahead of the pack, we're going to
have to work hard and continue to innovate.

I need to finish these reports. My boss needs them
ASAP.

I'm a little nervous about giving this presentation.
There's a lot at stake.

Our programmers identified what they thought the
problem was with the software. After working for
several hours, it turns out that the problem is something
totally different, so it looks like we have to go back to
square one.

The prototype wasn't successful. We have to go back to
the drawing board.

I think they got the government contract because of a
backroom deal.

I'm not sure what a Super Bowl commercial costs, but to
give you a ballpark figure, 1"d say about three million
dollars.

She didn't think it would be fair to go behind his back
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back

behind the scenes

big picture

blue collar

by the book

call it a day
catch someone off

guard

cave (or cave in)

change of pace

come up short

someone's back™ means to do
something without someone's
knowledge and in an unfair way.

What happens in secret or not in
front of the general public is said
to happen "behind the scenes."

Everything that is involved with a
particular situation is called "the
big picture.”

A "blue collar worker" is someone
who works with his or her hands
(manufacturing, construction,
maintenance, etc.). The opposite is
a "white collar worker." A white
collar worker is someone who
works in an office (customer
service, management, sales, etc.)
"Blue collar" (and "white collar™)
can also be used to describe a job,
position, or a place.

To do things "by the book" means
to do things according to company
policy or law. It means to follow
the rules 100%.

To "call it a day" means to decide
to stop working for the day.

To "catch someone off guard"
means to surprise someone by
doing something that he or she was
not expecting.

If someone "caves"” or "caves in" it
means that the person gives in to
something or agrees to something
that he or she previously did not
want to accept.

"A change of pace" is something
different from a normal routine or
schedule.

To "come up short" means to try to
achieve something but fail. We
often say that someone has "come

and talk to management, so she confronted him directly.

They make it look so effortless, but they do a lot of hard
work and planning behind the scenes.

Even though we all have very specific tasks to do, our
manager makes sure we don't lose sight of the big
picture.

It's a blue collar town with a lot of farmers and factory
workers.

We are regularly audited by several regulatory agencies.
It's important that we do everything by the book.

Well, John, it's 7:00 and I'm getting hungry. How about
we call it a day?

Mike was caught off guard when they asked him to
direct the meeting.

The employees complained about the change in policy,
but the supervisor refused to cave in.

It's nice to go on business trips because

it's a change of pace.

The charity fund raiser was supposed to raise three
million dollars, but they came up short.
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corner a market

cut corners

cut one's losses

cut-throat

diamond in the
rough

gasy come, easy go

fifty-fifty

from the ground up

game plan

get back in/into the

swing of things

get down to business

up short" when someone fails to
achieve a goal, but not completely.

To "corner a market" means to
dominate a particular market.

To "cut corners™ means to take
shortcuts and find an easier or
cheaper way to do something.

If you stop doing something that is
unproductive and won't ever
generate results, you "cut your
losses."

"Cut-throat" is used to describe
something that is very intense,
aggressive and merciless.

A "diamond in the rough" is
something or someone that has a
lot of potential but first requires a
lot of work.

"Easy come, easy go," is an
expression used to communicate
that something gained easily is
also lost easily. We often use this
expression after something has
been lost.

"Fifty-fifty" means something is
divided equally -- 50% for one
person, 50% for the other person.

If you start a business, project, or
something else from zero, you start
it "from the ground up."

A "game plan" is a strategy or
plan.

To "get back in/into the swing of
things" means to get used to doing
something after you have had a
break from that activity.

To "get down to business" means
to stop making small talk and start
talking about serious topics related

Apple has cornered the market on mp3 players. They
have a large percentage of market share.

We don't cut corners on our luxury products.

Our advertising campaign was expensive and not
showing results, so we cut our losses.

In business school, the competition was cut-throat.

He was a diamond in the rough. He was intelligent and
had great ideas, but his management and English skills
weren't very good.

A lot of people who inherit money waste it on stupid
things. | guess it's easy come, easy go.

My business partner and | split everything fifty-fifty.

Bill Gates built Microsoft from the ground up.

They're not sure what their game plan is for the
upcoming election.

Our company shuts down operations for three weeks
during the holiday season. When | go back to work in
January, it's difficult to get back in the swing of things.

Now that everyone's here, let's get down to business and
talk about the proposal.
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get something off the

ground

get the ball rolling

get/be on the good

side of someone

get/have foot in the
door

give someone a pat
on the back

give the thumbs

down

give the thumbs up

go broke

go down the drain

go the extra mile

go through the roof

gray area

to business.

To "get something off the ground”
means to start a project or
business.

To "get the ball rolling” means to
start something (a project, for
example).

If someone likes you, you are "on
the good side" of that person.

To "get or have your foot in the
door" means to take a low-level
position with a company with the
goal of eventually getting a better
position with the same company.

To "give someone a pat on the
back™ means to tell someone that
he or she did a good job.

To "give something or someone
the thumbs down" means to deny
approval.

To "give something or someone
the thumbs up™ means to give
approval.

To "go broke™ means to go
bankrupt or to lose all the money a
person or business had.

When you waste or lose
something, it is said to "go down
the drain."”

To "go the extra mile" means to do
more than what people expect of
you.

If something is "going through the
roof," it means it is increasing very
quickly.

If something is in a "gray area" it
means that it is something
undefined and not easily

We're very glad that the planning process is over. We're
looking forward to getting the project off the ground.

We need to get the ball rolling on this project. The
deadline is in June, and it's already April.

I always remember my coworkers' birthdays and get
them a card or small gift. I like to get on people's good
side.

My son just took a low-paying internship position with a
large company. He was happy to get his foot in the door
at a well-known, respected company.

The boss gave Brian a pat on the back for coming up
with such a good idea.

I can't believe she gave us the thumbs down. I thought it
was a great idea.

They gave our new proposal the thumbs up. We're going
out to celebrate tonight.

There was too much competition and their expenses
were too high. They eventually went broke.

He dropped out of college in his third year and never
continued his studies. All of his hard work and money
went down the drain.

We go the extra mile for our customers. If someone is
dissatisfied with a purchase, we refund their money and
offer them a discount on their next purchase.

We're really happy that our number of Facebook
followers has gone through the roof.

I asked our lawyers if it was legal, and they said it
wasn't clear. It's in a gray area.
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ground-breaking

hands are tied

have someone’s
work cut out

hit the nail on the
head

in a nutshell

in full swing

in the black

in the driver's seat

in the red

keep your eye on the

ball

last straw

learn the ropes

categorized.

If something is "ground-breaking"
it means it is new and innovative.

If you do not have any control over
a situation, your "hands are tied."

If you have a lot of work to do or a
particularly difficult assignment,
you "have your work cut out for
you."

To "hit the nail on the head" means
to do or say something 100%
correctly.

"In a nutshell" means in a few
words.

If a project is "in full swing," it
means that it has been completely
started and that it is progressing or
moving as fast as it ever will.

If a company is "in the black," it
means that they are making a
profit.

To be "in the driver's seat" means
to be in control.

If a company is "in the red," it
means that they are not profitable
and are operating at a loss.

To "keep your eye on the ball"
means to not lose focus on what
you want to achieve.

The "last straw™ means the last
annoyance, disturbance, or
betrayal which causes someone to
give up, lose his or her patience, or
become very angry.

To "learn the ropes" means to learn
the basics of something.

The iPhone was a ground-breaking piece of technology
when it was released in 2008.

I would love to get you a job at my company, but my
hands are tied. Management isn't hiring any additional
employees this year.

She has to sell $35,000 worth of products by the end of
the month. She has her work cut out for her.

I agree with John 100%. I think he really hit the nail on
the head.

In a nutshell, this book is about how to motivate
employees.

Construction on the new site is in full swing now.

We're not having a great year, but at least we're in the
black.

I'm not used to being in the driver's seat. | should
probably buy some management books.

When | started my own business, we were in the red for
the first two years. We didn't see a profit until the third
year.

I know we can do it. We just need to keep our eye on the
ball and not lose focus.

Our boss had been unhappy with Brian's performance
for a while, but it was the last straw when he came to
work three hours late without calling.

I like my new position.

I'm starting to learn the ropes.
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long shot

loophole

lose ground
(opposite is to ""gain
ground")

lose-lose situation
(also called a ""no-
win situation')

nine-to-five

no brainer

no strings attached

no time to lose

not going to fly

off the top of one's
head

A "long shot" is something that has
a very low probability of
happening.

A legal "loophole" occurs If a law
is unclear or omits information.
This lack of legal clarity allows
people or corporations to take
advantage of the situation and pay
less in taxes or gain some other
advantage.

To "lose ground" means to lose
some type of an advantage (market
share, for example) to a
competitor.

A "lose-lose situation™ is when
there will be a negative outcome
regardless of what decision is
made.

A "nine-to-five" is a job during
normal working hours. The term
came into existence because many
work days start at 9 AM and end at
5PM.

If a decision is really obvious or
really easy to make, the decision is
a '"no brainer."

If something is given without
expecting anything in return, it is
given with "no strings attached."

If there is "no time to lose," it
means that there is a lot of pressure
to complete something quickly.

If a solution isn't effective, people
say that it "isn't going to fly."

If someone says something "off
the top of his or her head," it
means that he or she gives a
response without thinking about it
much or doing any research on the
subject.

Winning the lottery is a long shot, but millions of people
still buy lottery tickets.

Some people complain that millionaires avoid paying
taxes by finding loopholes in tax laws.

Apple lost some ground to Samsung last quarter.

It's a lose-lose situation. If they lay off more workers,
they'll get bad press. If they don't lay off more workers,
they won't be able to compete.

She was tired of working a nine-to-five job, so she took
her savings and started a restaurant.

Taking the new job was a no brainer. They offered me
more money, a better schedule, and more vacation days.

They will let you try the product for free with no strings
attached. If you don't like it, there is no pressure to buy
it or give them anything in return.

I told them I'd send the email by the end of the day and
it's already 4:45. | need to get to work. There's no time
to lose.

I don't think that's going to fly. Let's keep generating
ideas.

I have no idea how many branches they have. Off the
top of my head, I'd say about 20.
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on a roll

on the ball

on the same page
page

on top of something

on your toes

out in the open

out of the loop
(opposite: in the
loop)

pink slip

play hardball

put all someone's
eggs in one basket

put the cart before
the horse

raise the bar

If someone is "on a roll," it means
that he or she has had several
SUCCESSES N a row.

To be "on the ball" means to be
alert and aware of things.

If two people are "on the same
page,” they are in agreement about
something.

To be "on top of something"
means to be in control of a
situation and aware of changes.

To be "on your toes" means to be
alert.

If something is "out in the open” it
is public knowledge and not
hidden from people.

To be "out of the loop™ means to
not know something that a select
group of people knows. The
opposite, "to be in the loop,"
means to be part of a select group
with knowledge that others do not
have.

If someone gets the "pink slip," it
means they have been fired.

To "play hardball" means to be
competitive in a cruel and
merciless way. Playing hardball
means doing anything possible to
win.

To "put all someone's eggs in one
basket," means to rely on only one
thing to bring you success.

To "put the cart before the horse"
means to do or think about things
in the wrong order.

To "raise the bar" means to set the
standards or expectations higher,
usually by achieving or creating
something better than what had

Our profits have been above our projected numbers for
five months in a row. We're really on a roll.

My new personal assistant is working out well. He's
really on the ball.

Let's go over the details of what we agreed on to make
sure we're on the same page.

I read a lot to stay on top of the latest changes in my
industry.

Stay on your toes. Anything can happen.

I think it's a good policy to do things out in the open
because people get suspicious if you do things in secret.

| felt like | was out of the loop after being on vacation
for two weeks.

They gave him the pink slip. He wasn't performing very
well.

He played hardball to get where he is, so | would be
careful what you say and do around him.

It's not good to only invest in the stock market. You
don't want to put all your eggs in one basket.

They were trying to find investors without even having a
business plan. They were putting the cart before the
horse.

The new software is getting great reviews. It looks like
they've really raised the bar for the competition.
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read between the
lines

red tape

rock the boat

round-the-clock

run/go around in
circles

safe bet

same boat

second nature

see eye to eye

see something
through

previously existed.

To "read between the lines" means
to understand something that
wasn't communicated directly.
Reading between the lines
involves understanding what
someone is implying or suggesting
but not saying directly.

"Red tape" refers to excessive
rules, procedures, and regulations
that make it difficult to accomplish
something. We usually use "red
tape" to talk about government
requirements that create difficult,
time-consuming barriers for people
and businesses.

To "rock the boat" means to cause
problems or disrupt a peaceful
situation.

"Round the clock™ means 24 hours
a day.

To "run (or go) around in circles"
means to do the same thing over
and over again without getting any
results.

A "safe bet" means something that
will probably happen.

If people are in the same situation,
they are in the "same boat."

When someone learns how to do
something so well that it appears
that he or she was born knowing
how to do it, we say that the
activity is "second nature™ to him
or her.

To "see eye to eye" with someone
means to agree with that person.

To "see something through" means
to do something until it is finished.

He didn't say that he wants to leave the company, but |
can read between the lines. He's thinking of getting a
new job.

The new law is going to create a lot of red tape and
we're going to have to pay our lawyers a lot more
money.

He thought about demanding a raise, but then he
decided he didn't want to rock the boat.

We have round-the-clock production at all our
manufacturing facilities.

I've made phone calls all day and haven't made a single
sale. | feel like I've been running around in circles all
day.

It's a safe bet that smartphones will be much more

advanced in 10 years.

We're all worried about losing our jobs. We're in the
same boat.

He's been a computer programmer for ten years. At this
point, programming is second nature to him.

We don't always see eye to eye, but I respect her
opinions and appreciate her honesty.

I told my boss that I really wanted to see this project
through before taking on another project.
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sever ties

shoot something
down

sky's the limit

small talk

smooth sailing (or
clear sailing)

snail mail

stand one's ground

start off on the right
foot

start off on the
wrong foot

state of the art

take something lying
down

take the bull by the
horns

talk someone into
something

To "sever ties" means to end a
relationship.

To "shoot something down" means

to deny something, such as a
proposal or idea.

"The sky's the limit" if there is no
limit to what can be achieved.

"Small talk™ is conversation about
unimportant topics that do not
offend people (the weather, for
example).

"Smooth sailing" is a term used to
describe a situation where success
is achieved without difficulties.

"Snail mail" is the term used for
the traditional mail that goes
through the post office.

If you "stand your ground," it
means that you will not change
your opinion or position.

To "start off on the right foot"
means to start something in a
positive way.

To "start off on the wrong foot"
means to start something in a
negative way.

Something that is "state of the art"
is modern and technologically
advanced.

To "take something lying down"
means to accept something
unpleasant without fighting back.

To "take the bull by the horns”
means to directly confront a
difficult situation.

To "talk someone into something"
means to convince someone to do
something.

We had to sever ties with several of our suppliers due to
late shipments.

It's best not to shoot down people's ideas during a
brainstorming session. The goal is to generate ideas, not
to criticize them.

With their commission structure, the sky's the limit to
what you can make.

We typically spend about 15 minutes making small talk
before we start our meetings.

Once our largest competitor went out of business, it was
smooth sailing.

If you want to fill out form 52-E and send it to the
government, you have to do it using snail mail. They
don't allow you to scan the document.

We tried to change the dress code, but Human
Resources stood their ground.

We offered them a very generous price on their first
order and everything shipped on time. We really started
off on the right foot.

I just switched cable companies. They overcharged me
for the first month's service. They really started off on
the wrong foot.

Bill Gates lives in a state-of-the-art home with a lot of
modern technology.

The proposed law would kill our industry, but we're not
going to take it lying down. We're going to fight back
and try to make sure the law doesn't get passed.

One of our mid-level managers wasn't very popular and
was causing some problems, so we took the bull by the
horns and replaced him with somebody else.

I was hesitant to redesign our website, but my
employees talked me into it. I'm glad they did. The new
site looks great.
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talk someone out of
something

the elephant in the

room

think big

think outside the
box

throw in the towel

time's up

touch base

twist someone's arm

under the table

up in the air

uphill battle

upper hand

white collar

To "talk someone out of
something™ means to convince
someone not to do something.

"The elephant in the room" refers
to an obvious problem or
controversial issue that no one
wants to talk about.

To "think big" means to have high
goals and big plans for the future.

To "think outside the box" means
to think of creative solutions
instead of common ones. Thinking
outside the box involves thinking
of unconventional ideas.

To "throw in the towel" means to
quit.

"Time's up" means that the time
for something or someone has
ended.

To "touch base" means to make
contact with someone.

To "twist someone's arm" means to
persuade or convince someone to
do something that he or she does
not want to do.

Something done secretly (and
usually illegally) in the business
world is done "under the table.”

If something is undecided, it is "up
in the air."

Something that is difficult to
achieve because of obstacles and
difficulties is an "uphill battle.”

If someone has an advantage over
someone else, he or she has the
"upper hand."

A "white collar worker" is
someone who works in an office

I wanted to make a real estate investment, but my
financial adviser talked me out of it.

We should have been talking about our huge debt but no
one wanted to talk about the elephant in the room.

I'm not content with just opening one or two more
stores. I'm thinking big -- I think we can open 10 stores
in the next five years.

Creating a completely new product that no one has ever
sold before is an example of thinking outside the box.

I was trying to learn Portuguese, but | got frustrated and
threw in the towel.

I think his time's up as the CEO. They're going to
replace him as soon as they find a suitable candidate.

Let me make a few phone calls to try to get an answer to
your question. I'll touch base with you later today.

The owner thought the budget was a little high. We had
to twist his arm to get him to agree to it.

To avoid paying taxes, they paid some of their
employees under the table.

We're looking for a test market right now, but nothing
has been decided yet. Everything's still up in the air.

Winning the election is going to be an uphill battle. He
doesn't have a lot of support at the moment.

He was more experienced and well respected, so he had
the upper hand in the argument.

There are mostly manufacturing positions here. There
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win-win situation

word of mouth

writing on the wall

yes man

(customer service, management,
sales, etc.) The opposite of a white
collar worker is a "blue collar
worker." A blue collar worker is
someone who works with his or
her hands (manufacturing,
construction, maintenance, etc.)
"White collar" (and "blue collar")
can also be used to describe a job,
position, or place.

A "win-win situation" is a situation
where everyone involved gains
something.

If something spreads by "word of
mouth," people hear about it by
informal conversation with friends,
family members, acquaintances,
etc.

The "writing on the wall" refers to
the evidence and clues that
something (usually negative) is
going to happen.

A "yes man" is someone who
always agrees with his or her
superiors.

COMMON PHRASAL VERBS

Phrasal Verb

to ask around

to back * up

to call * back

to call * off

to not care for

aren't many white-collar jobs.

We were happy to get the contract, and they were happy
to get such a good price. It was a win-win situation.

Many local restaurants rely on word of mouth to get
new customers.

I'm going to get my resume ready. | can see the writing
on the wall.

The company isn't looking to hire someone who is going
to try to make a lot of changes. They're just looking for
a yes man.

Definition Example

to ask many people the same question | need a good real estate agent. Could you ask
around the office and see if anyone knows one?

to support Thanks for backing me up in the meeting.

to return a phone call

to cancel

to not like (formal)

We have a bad connection. I'll call you back in a
few minutes.

Management is going to call the meeting off
because so many people are out sick today.

I don't care for team building activities. | think
they are a waste of time.
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to check in

to check out

to check * out

to chip in (also to pitch

in)

to come across

to count on

to cut back on

tocutin

to do * over

to do away with

to drop by

to drop * off

to end up

to figure * out

to fill * out

to find out

to get * back

to arrive and register at a hotel or

airport

to leave a hotel

to look at carefully, investigate

to help

to find unexpectedly

to rely on

to consume less

to interrupt

to do again

to discard; to put an end to

come without an appointment; to visit

briefly

to take someone/something somewhere

and leave them/it there

to eventually reach, do, or decide

to understand; to find the answer

to write information in blanks

to gain knowledge about something

to receive something that you had
before

We checked in at 5 PM and then went to get
something to eat.

We checked out a few hours late and had to pay
an extra fee.

I'm not sure why the copier isn't working. I'll
check it out.

We should be able to finish quickly if everyone
pitches in.

I was reading last night and | came across a
couple of phrasal verbs I had never seen before.

We have a great team. | can count on everyone to
do their best.

It's a tough economy. We're trying to cut back on
unnecessary expenses.

Can I cut in and say something, please?

| can't believe | closed the document without
saving. Now I'm going to have to do the whole
thing over.

They did away with bonuses last year because
their profits were so low.

John dropped by my office to talk about last
month's figures.

My car was in the shop, so Kevin dropped me off
at my house.

At first | thought | wanted to be an accountant.
Then, I studied finance. | ended up getting my
degree in management, though.

I can't figure out why the printer isn't working.
I've tried everything, and it still won't work.

There were a lot of forms to fill out when | got
my new job.

I finally found out how to forward my mail from
one email account to another.

You can borrow my stapler, but make sure | get
it back when you're done with it.
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to get back at

togetin

to get over

to get together

to get up

to give in

to give * up

to give up

to go after

to go against

to go over

to hand *in

to hand * out

to hang on

to retaliate; to take revenge on
someone

1. enter

2. arrive

to recover

to meet (but not for the first time)

1. to get out of bed

2. to stand

to reluctantly stop fighting or arguing

to quit a habit or quit doing a certain
activity

to stop trying

1. to follow someone

2. to try to achieve something

to compete; oppose

to review

to submit (a report, a paper, etc)

to distribute the same thing to a group
of people

to wait for a short time (informal)

He might get back at you for asking him so many
tough questions during his presentation.

1. Get in the car. I'll give you a ride.

2. | worked late last night and didn't get in until
after 9 PM.

I was upset that | didn't get the promotion, but |
got over it after a while.

This weekend I'm going to get together with
some friends from college.

1. I get up late on the weekends because | have to
get up really early on weekdays.

2. He got up and walked to the podium to give
his speech.

Management didn't want to give in to the union's
demands, but in the end they didn't have a
choice.

I gave up checking Facebook at work. I'm trying
to be more productive.

Just because we failed the first time doesn't mean
we should give up. We just need to change a few
things.

1. Pam will give her talk first, and Scott will go
after her.

2. If we got the account, they would be our
biggest client. I'm really going to go after the
account.

We're going against three or four other
contractors. Be sure to bid low.

I want to go over last month's numbers with you.

| forgot to hand in my expense reports. Now |
won't get reimbursed until next month.

I'll start explaining the changes while Jason
hands out a copy of the new policy.

Could you hang on for a second, please? I'll be
right there.
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to keep * up

to let * down

tolet *in

to look forward to

to look into

to look out for

to look * over

to look up to

to make up

to make * up

to mix * up

to pass * out

to pass * up

to put * off

to put * together

to runinto

to continue doing something

to disappoint; to not help or support

to allow to enter

to be excited about something in the

future

to investigate

to be careful, vigilant, and take notice

to check; examine

to have a lot of respect for someone

to resolve an argument or quarrel

1. to invent (a story, lie, excuse,

reason, etc.)

2. to compensate for something

to confuse two or more things

to give the same thing to many people

to decline (usually something good)

to postpone

to assemble

to meet someone unexpectedly

You've been doing really well lately. Keep it up!

I was really depending on him to expedite the
shipping on that order. The products are still in
the warehouse. He really let me down.

| forgot my badge again. Hopefully someone else
is in the office and can let me in.

I'm really looking forward to having an extended
weekend next week.

Please look into some ways we can cut costs.
Every penny counts.

You must always look out for new business
opportunities.

Could you look over this report to make sure
there are no mistakes?

I really look up to her. She has been with the
company for a long time and is really
knowledgeable.

Are they still fighting about that? | thought they
had made up a while ago?

1. 1 don't believe their story. | think they made it
up.

2. | didn't get anything accomplished yesterday.
I'm going to have to work extra hard to make up
for it today.

I always mix their names up. Which one is Bob,
and which one is Brad?

Carly is passing out a schedule of today's events.

Don't pass up on this great opportunity. Place
your order today.

I haven't done my taxes yet. I've been putting it
off for a long time.

How long will it take to put the scale model
together?

I ran into Stacey from Accounting in the
supermarket yesterday.
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to send * back

to set * up

to shop around

to sort * out

to take * back

to think * over

to turn * down

to try * out

to use * up

to return

to arrange;organize

to compare prices

to organize or resolve a problem

1. to return an item

2. to retract a statement

to consider

1. to decrease the volume or strength
of something (volume, heat, etc)

2. reject an offer

to test or use something experimentally

to finish the supply

The product was defective. We'll have to send it
back.

I'll set up the conference call and send you an
invite.

We should bid low on this one. They always
shop around.

There was some confusion with the new work
schedule. No one is sure who works on Sunday.
We're calling a meeting to sort it out.

1. She always shops there because she knows
that she can take anything back that she isn't
happy with.

2. 1 didn't mean it. | take it back.

Honestly, | don't know what I'm going to do. The
job offer is great, but I'm not sure if | want to
leave my current position. I'll have to think it
over.

1. Could you turn your music down so | can take
this call?

2. They turned down our proposal.

We're going to try it out for a few weeks and let
you know what we think. If we like it, we'll place
an order.

| can't believe it's only May and I've used up all
my sick days already.
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WORDS & PHRASES BY BUSINESS AREA

EMPLOYMENT; This is a list of words typically used for human resources or hiring staff.

Word

assessment
background
bonus
curriculum vitae
dismiss
employee
employer

fire

fringe benefits

hire

interview

make redundant
maternity leave
notice

personnel
personnel officer
promotion
prospects
recruit

resign

retire

sick leave

staff

strength

strike

take on

trainee
training course

unemployment benefits

vacancy
weakness

Meaning

Evaluation of one's abilities

Education - qualifications - experience

Additional payment to an employee as an incentive or reward
Summary of one's education and experience to date; resume
Discharge from employment (to fire, to sack, to let go)

Person who works for a firm or company.

Person or firm who employs people.

To dismiss from a job.

Advantages offered in addition to salary (life insurance, retirement scheme, company
car, etc.).

Also called 'perks’, abbreviation for 'perquisites'.

Employ or take on personnel in a company.

Oral examination of a candidate for employment.

Dismiss for economic reasons.

Period of absence for a female employee when having a baby.
Advance warning of intention to leave one's job -

to give or hand in one's resignation.

People who work for a firm or company (employees).
Manager responsible for recruitment, training and welfare of personnel (employees).
Advancement in rank or position in a company.
Opportunities for success or promotion in a career.

Look for and hire personnel.

Leave a job voluntariily.

Leave employment because of age.

Absence because of illness - to be on sick leave.

People who work for a firm or department; employees.
Strong characteristic or particular ability.

To go on strike : to stop working in protest against something.
Employ or hire.

Person being trained for a job e.g. a trainee salesman.

A course of study to prepare for a job e.g. a computer course.
Payments made by the state to an unemployed person.

A position to be filled.

A lack of ability or a shortcoming in character.

MEETING,; This is a list of word related to meetings or conferences at the work place.

Word

A.G.M.
absentee
agenda
alternative
attendee
ballot

Meaning

Annual General Meeting

Person not at the meeting, not present.

Written list of points to be discussed at a meeting.
Choice of two or more possibilities.

Participant or person attending a meeting.

System of secret voting;

57



casting vote

chairman / chairperson
clarify
conference
conference call
coNnsensus
deadline
decision
i-conference
interrupt

item

main point
minutes
objective

point out
proposal
proxy vote
recommend
show of hands
summary

task
unanimous
video conference
vote

voters place their ballot-papers in a ballot-box;

Deciding vote, usually by the Chairman, when votes are

in equal number.

The person who conducts the meeting.

Make something clearer by giving more information.

Formal meeting for discussion or exchange of views.

Telephone call between three or more people in different places.
General agreement.

Future date at which something must be done.

Reach a conclusion or resolution concerning future action.

A meeting or discussion between two or more people via the internet.
Stop a person who is speaking in order to say or do something.

A separate point for discussion on an agenda.

What is most essential.

A written summary of the proceedings at a meeting.

What is aimed at, what one wants to achieve or obtain.

Draw attention to something e.g. point out an increase in demand.

A course of action put forward for consideration; to make a proposal.
A vote cast by one person for another.

Advise a course of action; make a recommendation.

Raised hands to express agreement or disagreement in a vote.

A brief statement of the main points.

A piece of work to be done; to assign a task to someone.

In complete agreement.

Conference linking people in different locations by satellite, TV, etc.
Express one's agreement or disagreement; to cast a vote.

COMPUTER & INFORMATION TECHNOLOGY:; This is computer and technology words used at the business

place by IT departments.

Word

adware

application
bloatware/fatware
browser

bug

cache

cookies

crash

cursor

Meaning

A software application which displays unwanted pop-up advertisements on your
computer while in use. Adware is often installed at the same time as free software or
shareware.

Any program designed to perform a specific function directly for the user. Microsoft
Word, Outlook or Adobe Photoshop are examples of application programs.
Pre-installed software that occupies a lot of space, leaving little memory for storing
personal data.

A program or tool such as Internet Explorer, Mozilla Firefox or Google that enables
you to browse or surf the World Wide Web and view internet sites.

A defect or fault in a program that prevents it from working correctly. Bugs are
caused by mistakes or errors made by those who write the program.

A sort of fast memory used for temporary storage of recently accessed web pages,
which enables the browser to display them more quickly on the next visit.

Small piece of information on the times and dates you have visited web sites. A web
server can temporarily store this information within your browser. The main purpose
is to identify users and possibly prepare customized web pages for them.

What happens when a program or the entire operating system, unexpectedly stops
working.

A blinking symbol on the screen that shows where any new text will next be entered.
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driver

e-business
e-mail
FAQ
firewall

font
hardware

hit
home page
login

A special program which enables a computer to work with a particular piece of
hardware such as a printer.

Business done over the internet or any internet-based network.

Electronic mail : messages sent from one computer to another over the internet.
Frequently Asked Questions.

Specialized hardware or software designed to prevent unauthorized access into or out
of a computer or network.

A particular kind of lettering (e.g. Arial, Verdana, etc.)

The physical equipment or touchable parts of a computer system (the CPU (central
processing unit), monitor, keyboard, mouse, external speakers, scanner the printer,
etc.)

A visit to a website.

The main page or opening page of a website. It usually contains links to other pages.
Process by which a user enters a name and password to access a computer.

NEGOTIATION; This is a list of words that relates to business negotiations and or potential deals.

Word

agent
agreement
bargain price
bedrock price
commitment
compromise
condition
contract
counter-offer

counter-productive

deal
discount
estimate
facilities
feasible
figure out
know-how
joint venture

negotiate
point out
proposal

guote

range

rebate

supply
supplier
tender
turnkey
underestimate
work out

Meaning

Person or company that acts for another and provides a specified service.
Arrangement between two or more people or companies.

Reduced price

Lowest possible price.

Engagement or undertaking; to commit oneself.

Each party gives up certain demands in order to reach an agreement.
A stipulation or requirement which must be fulfilled.

Written agreement between two or more parties.

Offer made in response to an offer by the other party.

Having the opposite effect to that intended.

A business transaction.

Reduction in price.

Approximate calculation of the cost.

Equipment (e.g. parking facilities).

Possible, something that can be done.

Find a solution; estimate the cost.

Practical knowledge or skill.

A way of entering a foreign market by joining with a foreign company to manufacture or
market a product or service.

Discuss a business deal in order to reach an agreement.

Draw attention to something (e.g. the advantages of your proposal).
Course of action, or plan, put forward for consideration;

to make a proposal.

Give an estimated price (a quotation).

A selection of products sold by a company.

Reduction or discount.

Provide customers with goods or services.

Person or company that supplies goods or services.

A written offer to execute work or supply goods at a fixed price
Equipment ready for use or operation (e.g. a plant or factory).
Make too low an estimate of something (cost, danger, difficulty).
Calculate (e.g. price of something); find a solution.
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TELEPHONE EDUCATE

Introducing yourself

o Good morning/afternoon/evening. This is Mike at (company name)/Mike from (department name). Could I speak
to (person you’re calling for)?

> Good morning/afternoon/evening. This is Mike at (company name)/Mike from (department name). /’m calling
about/because...

When the person you want to speak to is unavailable

o Can | leave a message for him/her?

o Could you tell him/her that I called, please?

o Could you ask him/her to call me back, please?
Okay, thanks. I'll call back later.

o

Dealing with bad connections

o | think we have a bad connection. Can I call you back?
o I'm sorry, we have a bad connection. Could you speak a little louder, please?
o ['m sorry, could you repeat that please?

Ending the call

o Thank you very much. Have a good day.
o Thanks for your help. Have a good day.

Answering the phone

o Company ABC, this is Mike. How may I help you?

o Good morning/afternoon, Company ABC. How may | help you?

o Purchasing department, Frank speaking.

Note: If we are taking an external call and talking to a customer, “How may I help you?” is common. If we are taking
an internal call, we normally do not say “How may I help you?” For internal calls, saying your name and your
department is usually sufficient. Getting the name of the caller if he/she doesn’t give it to you

o May | have your name please?
o Who am | speaking with?
o May | ask who’s calling?

Responding to a caller’s request

o Sure, let me check on that.
o Let me see if she’s available.
o Sure, one moment please.

60



Asking someone to wait on the line

o Can | put you on hold for a minute?
> Do you mind holding while I check on that (or “handle that for you,” “check to see if he’s available,” etc)

Taking a message

o He’s/she’s not available at the moment. \Would you like to leave a message?
o He’s/she’s out of the office right now. Can | take a message?

Dealing with bad connections/wrong numbers

o ['m sorry, we have a bad connection. Could you give me your number and I'll call you right back?
I think we have a bad connection. Could you speak a little louder, please?

o ['m sorry, could you repeat that?

o I'm sorry, you have the wrong number.

o

Ending the call

o [s there anything else I can help you with? ....Okay, thanks for calling. Have a great day.
o [s there anything else I can do for you?...Okay, have a good day.
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SPANISH TO ENGLISH

As English learners, we Spanish speakers use or translate into English words that may sound adequate but are being
misused. In this section we are going to highlight those mistakes and show the proper use of the English version.

actual # actual actually # actualmente | used to live in New York, but | actuaky live in Colorado. | used to live in
New York, but I currently live in Colorado. | used to work for the government, but my aetual job is in the private
sector. | used to work for the government, but my current job is in the private sector. actual means real or
verdadero in Spanish actually means de hecho

to assist # asistir | always assist my classes. | always attend my classes. assist means ayudar

to attend # atender She attended many customers today. She assisted/took care of/helped many customers
today. attend means asistir

bland # blando Cesium is the blardest metal in the world. Cesium is the softest metal in the world. bland means
insipido, soso or poco estimulante in Spanish Blando is usually translated as “soft,” or “smooth” depending on the
context.

career # carrera What was his eareer in college? What was his major in college? Career does mean carrera if we
are talking about una trayectoria profesional or una profesion. However, to talk about someone’s specialization in
college, we use the word “major.”

carpet # carpeta Kevin saved the document in a earpet on his desktop. Kevin saved the document in a folder on his
desktop. carpet means alfombra

college # colegio They really liked 9th grade, but they didn’t like the rest of their eoHege-experience. They really
liked 9th grade, but they didn’t like the rest of their high school experience. college means universidad

claim # clamar They elaimed about the bad service at the restaurant. They complained about the bad service at the
restaurant. claim means asegurar

compromise # compromiso Having children is a big eempremise. Having children a big
commitment. compromise means un mutuo acuerdo en que los dos lados hacen concesiones (it can also be used as a
verb)

deception # decepcion They were expecting to have a great time on vacation, but it was a big deception. They were
expecting to have a great time on vacation, but it was a big disappointment. deception means engafio

demand # demandar Did you hear about the woman who found a mouse in her soup and demanded-the restaurant? She
won $200,000! Did you hear about the woman who found a mouse in her soup and sued the restaurant? She won
$200,000! demand means exigir

explode # explotar They exploded the workers and didn’t pay them for the hours they worked. They exploited the
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workers and didn’t pay them for the hours they worked. Explode is translated as explotar if we are talking about an
explosion. However, if you want to say sacar provecho or abusar de alguien, the word in English is “exploit.”

fabric # fabrica His first job was working in a chemical fabrie. His first job was working in a chemical
factory. fabric means tela or tejido

familiar # familiar s it a famitiar movie? | want to know if | can bring my kids. Is it a family movie? | want to know
if 1 can bring my kids. Familiar can sometimes be translated as familiar if we are talking about something conocido.
However, we do not use “familiar” to talk about things related to a family.

globe # globo We bought glebes for the party and filled them with helium. We bought balloons for the party and
filled them with helium. globe means globo terraqueo

grass #grasa You shouldn’t eat fast food because it has a lot of grass. You shouldn’t eat fast food because it has a lot
of fat. grass means zacate

idiom # idioma Everyone says that Mandarin is a really difficult item. Everyone says that Mandarin is a really
difficult language. idiom means modismo or refran

inhabitable# inhabitable This house is dirty and there is no electricity. It’s totally irhabitable. This house is dirty and
there is no electricity. It’s totally uninhabitable. These words are complete opposites in English and Spanish. In
English “inhabitable” means habitable in Spanish. To talk about un lugar inhabitable, we say “an uninhabitable place.”

introduce # introducir She introduced the dirty dishes in the dishwasher. She put the dirty dishes in the
dishwasher. introduce means presentar

lecture # lectura Our teacher assigned the leeture on page 37. We have to read it and answer the questions. Our
teacher assigned the reading on page 37. We have to read it and answer the questions. lecture means leccion or sermon

library # libreria | need to go to the Hbrary to buy my textbooks for this semester. | need to go to the bookstore to
buy my textbooks for this semeseter. library means biblioteca

molest # molestar Loud noise melests me when I’'m trying to study. Loud noise bothers me when I’m trying to
study. molest means abusar sexualmente

parent # pariente  Many of my parents were at my cousin’s birthday party. Many of my relatives were at my cousin’s
birthday party. parent means padre (mama o papa)

plant # planta Do you want to take the elevator or the stairs? We’re going to the fourth plart: Do you want to take the
elevator or the stairs? We’re going to the fourth floor. Plant cannot be used to talk about un piso de un edificio. We use
“plant” to talk about flowers, trees, grass, etc.

professor # profesor My third grade professer, Ms. Osborne, was excellent. My third grade teacher, Ms. Osborne,
was excellent. Professor is only for a teacher at the university level.
63



realize # realizar They are going to realize the movie next year. They are going to make the movie next
year. Realizar can be translated many different ways. When you want to use realizar to mean ejecutar, we use the
verbs “make” or “carry out.” realize means darse cuenta

recipient # recipiente Do you have a recipient to put this leftover food in? Do you have a container to put this
leftover food in? recipient means receptor or destinatario

record # recordar I can’t reeerd much of what happened to me when | was a young child. I can’t remember much of
what happened to me when | was a young child. record (as a verb) means grabar

remove # remover Can you get her a spoon so she can remeve-her coffee? Can you get her a spoon so she can stir her
coffee? remove means sacar or quita

resume # resumir Could we resume-what we’ve agreed on so far today? Could we summarize what we’ve agreed on
so far today? resume means continuar, seguir or reanudar

retire # retirar If you see the waiter, ask him to retire-these plates. If you see the waiter, ask him to take away these
plates. Retire is usually only used to mean “to stop working” (jubilarse).

sane # sano We try to eat sane-foods that are not processed. We try to eat healthy foods that are not
processed. sane means cuerdo or sensato

scientific # cientifico Albert Einstein was a great seientific. Albert Einstein was a great scientist. Scientific is an
adjective in English. For example, un descubrimiento cientifico is “a scientific discovery” in English. The person is a
“scientist.”

sensible # sensible Her eyes are very sensible-to the light. Her eyes are very sensitive to the light. sensible means
sensato

support # suportar My girlfriend and I broke up because she couldn’t suppert-a long-distance relationship. My
girlfriend and | broke up because she couldn’t tolerate/stand/put up with a long-distance relationship. support can
mean apoyar, respaldar, or mantener

sympathetic # sympathetic Everyone likes being around her. She’s so sywmpathetic. Everyone likes being around her.
She’s so nice/kind/friendly. sympathetic means compasivo or empatico

Gltimamente # ultimamente Jacky has been going to the gym uttimately. Jacky has been going to the gym
recently. ultimately can mean basicamente, finalmente, or por ultimo

To practice, try this Spanish to English false friends practice activity.

Directly Translated Phrases
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We say at work, not in-thefeb 1 sometimes use Facebook when I'm #-thejob. | sometimes use Facebook when I’'m at
work.

We say I’'m not sure about... or I have a question about..., not Hhave-a-doubt +have-a-deubt about the homework. |
have a question about the homework. Saying “I have a doubt” isn’t necessarily incorrect, but it sounds unnatural. It’s
better to say “I’m not sure about...,” or “I have a question about...” instead.

We say I think..., not Ferme— when giving personal opinions Fere, the idea is okay. | think the idea is okay. It’s
not necessarily wrong to say “For me...” before giving opinions, but we don’t use “For me...” nearly as often as
Spanish speakers use Para mi... when giving opinions.

We say | think so, not Hhinkaes. Is John the guy in the blue shirt? Hhinkyres. Is John the guy in the blue shirt? |
think so. For the negative, we say I don’t think so, not Hhink-ne. Are you going to go out with us tonight? Hhink
nre. Are you going to go out with us tonight? I don’t think so.

We say | said yes/no, not | said that yes/no to communicate decir que si/no. They asked me to work overtime today,
but }saidthatne. They asked me to work overtime today, but I said no. | asked for a raise and they-teld-me-that
yes. | asked for a raise and they told me yes.

We say How long...?, not Fer-hew-muech-time-—2 to ask a question about a duration of time. Ferhew-much-time have
you lived in San Jose? How long have you lived in San Jose?

We say know how (+ infinitive verb), not knew-{+infinitive-verb} to talk about things someone can and can’t do. |
knewto-swim. | know how to swim. Does your child knew-to-read yet? Does your child know how to read yet?

We say | have no idea, not Fden’thave-anidea to communicate no tengo idea. What should we have for lunch? Fden’t
have-an-idea. What should we have for lunch? | have no idea.

When we introduce people, we say This is... or These are..., not He-is— They-are—, etc. Hey, Mike. Let me
introduce you to everyone. She-is-my-sister, Alison, and-they-are-my-parents: Hey, Mike. Let me introduce you to

everyone. This is my sister, Alison, and these are my parents. If we are talking about someone in the distance, we say
“that” or “those.” “Those are my parents over there,” for example.

We say leave me alone, not leave-me-inpeace. Leave-me-in-peace. I don’t want to talk right now. Leave me alone. |

don’t want to talk right now.

We say now is the time, not rew-iswhen. [’m not sure if Row-is-when to change jobs. I’m not sure if now is the time
to change jobs.

We say no wonder, not with-reasen to communicate con razon. ith-reasen you got a bad grade on the test. You didn’t
study at all. No wonder you got a bad grade on the test. You didn’t study at all.

We say from now on, not siree-rew to communicate desde ahora en adelante. Sinree-new he is going to be more
careful. From now on, he is going to be more careful.
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We say from (point in time) to (a point in time), not since{apoirtintimerto-{a-pointintime). | work since-8-AM-to-6
PM. 1 work from 8 AM to 6 PM.

We say less and less and more and more, not each-time-less or each-time-more: | am each-time-less interested in
watching this TV show. | am less and less interested in watching this TV show. This TV show is getting each-time
meore interesting. This TV show is getting more and more interesting. If the adjective is one syllable (good, bad, big)
or a two-syllable adjective ending in “y” (funny, busy) we would say “bigger and bigger,” “better and better,” “worse
and worse,” “funnier and funnier,” etc.

We say it’s the way she is, not it’s-her-way-ofbeing She works really hard and has trouble relaxing. It’s herway-of
being. She works really hard and has trouble relaxing. It’s the way she is.

We say get a new job/car, etc. not ehange-myjoblear. He said he was learning English so he could ehange-hisjob: He
said he was learning English so he could get a new job. We’re saving money so we can change-eurcar. We’re saving

money So we can buy anew car.

We say out of work, not witheutjob Edgar was witheutjob, so he was preparing his resume and looking for job
opportunities. Edgar was out of work, so he was preparing his resume and looking for job opportunities.

We say the (adjective) thing/part, not the-{adjective} to communicate things like lo bueno, lo malo, lo importante,

etc. Fhe-good about my new job is that | have a flexible schedule. The good thing/part about my new job is that | have
flexible schedule. Fhe-difficult about being a parent is making time for yourself. The difficult thing/part about being a
parent is making time for yourself.

We say there are five of us, not we-are-five; etc. We-arefive in my English class. There are five of us in my English

class. Similar Examples: We can’t beat your team. We-are-only-three-and-you-arefive: We can’t beat your team.
There are only three of us and five of you. Hew-many-areyeu? How many of you are there?

We say Who are you rooting for? or Who do you want to win?, not \Whe-are-you-geing-with? when we ask someone
which team he or she wants to win a game. Whe-are-you-geing-with, Real Madrid or Barcelona? Who are you rooting
for, Real Madrid or Barcelona? Who do you want to win, Real Madrid or Barcelona?

Word Order

We don’t normally start a sentence with probably. We normally use probably before the main verb or after the verb to

be. Probablywe-have a test this week. We probably have a test this week. Prebably-they-are twins. They probably
are twins. They 're probably twins.

We don’t use always to start a sentence. We use always before the main verb or after the verb to be. Abways,-he-goes

to the beach. He always goes to the beach. Adways;-theyre late for class. Fhey-always-are late for class. They re
always late for class.

We don’t place an adverb between the verb and its object. +study-freguenthEnghish on the weekend. | frequently
study English on the weekend. Kate-goes-usuathytowerk at 7:30 AM. Kate usually goes to work at 7:30 AM.
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We place the adverbs a lot and very much after the object of a sentence. They likealotpizza: They like pizza a
lot. She levesvery-much-hereats: She loves her cats very much.

We usually put frequency statements (once a week, three times a year, once in awhile, etc.) at the end of the sentence. |

drink-every-morning-a-strong-cup-ofcoffee. | drink a strong cup of coffee every morning. Yeu-sheuld-ge-twicea-year
te-the-dentist. 'You should go to the dentist twice a year.

We say like (something) more, not like-mere{semething). Gary likesmere-basebal than soccer. Gary likes baseball
more than soccer.

We say number + more + noun, not rumber+noun-+mere. We only have three-days+ore of class. We only have
three more days of class. Jack has worked here for bwe-years-mere than anyone else. Jack has worked here for two
more years than anyone else.

Articles

We don’t use the article “the” when we are talking about a non-specific group. If we are talking about a specific group,
we use “the.” In general, | like the-degs. In general, | like dogs. (non-specific) Begs outside my house were barking
last night and | couldn’t sleep. The dogs outside my house were barking last night and I couldn’t sleep. (specific group)

We don’t use the article “the” before sports if we are speaking about the sport in general | love the-baseball: | love
baseball. What is your favorite sport? Mine is-the-soecer- What is your favorite sport? Mine is soccer. It is possible
(but not common) to use “the” before sports if we are talking about something very specific. The baseball they play in
the Dominican Republic is a little different from what I'm used to, for example.

We don’t use the article “the” before academic subjects if we are speaking about the subject in general. | love the
scienee, but | hate the-histery= | love science, but | hate history. 1t is possible to use “the” before an academic subject
if we are talking about something specific. I'm reading about the history of the Incan civilization, for example.

We don’t use the article “the” before expressions like last week, last January,next week,next Thursday, etc. Twon’t be
here the-next-weekend. 1 won’t be here next weekend. FhelastJdanuary it snowed a lot in the United States. Last
January it snowed a lot in the United States.

If we are talking about where someone is going, we use “the” before some places, but not others. go to the park go to
the gym goto the pool go tothe mall go to the supermarket go to the beach go to the bank go to the post
office  gotowork gotoschool gotoclass gotocourt gotochurch Idon’tfeel well. I don’t know if I’ll ge-te
the-werk tomorrow. T don’t feel well. T don’t know if I’1l go to work tomorrow. They wentto-the-scheol yesterday
even though it was snowing. They went to school yesterday even though it was snowing. Note that if we are talking
about a specific school, class, court, or church, we might use “the.” For example, | have history on Friday mornings, but
I've only been to the class once.

We use “the” before certain countries. the United States the United Kingdom the Czech Republic the Dominican

Republic the Netherlands the Philippines the Bahamas the Maldives the United Arab Emirates the

Sudan General rules for when we use “the” for a country. 1. If the country or area is a collection of islands (the

Maldives, the Canary Islands). 2. If we are using the complete name of the country with the word “of.” The People’s
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Republic of China, for example.

We use possessives (my, your, his, her, their, our, Mike’s, Kate's, etc.), not “the” for body parts. Open the
mouth. Open your mouth. John breke-thearm- John broke his arm.

We don’t use the article “the” before percentages if we are talking about an exact number. Almost-the-60%-of
Americans disagree with the president’s decision. Almost 60% of Americans disagree with the president’s decision. If
we do not say the exact number, we use “the.” The percentage of people who don’t have a car is increasing, for
example.

We don’t use the article “the” before double, triple, quadruple, etc. 1 can’t see you my car for that price. Someone
already offered me the-deuble that price. I can’t see you my car for that price. Someone already offered me double that
price.

We don’t use the article “the” before both. | like the-beth options. | like both options.

We don’t use the article “the” before numbered items in a list or series. Did you do the math homework? | had trouble
with the-number14.  Did you do the math homework? | had trouble with number 11. | was surprised by-the-rumber
five on People Magazine’s list of the sexiest people alive. | was surprised by number five on People Magazine’s list of
the sexiest people alive.

We don’t use the article “the” before heaven or hell. She told me to go to-the-hell. She told me to go to hell. Did you
read the book about the kid who almost died and had a vision of the-heaven? Did you read the book about the kid who
almost died and had a vision of heaven?

We use the article “the” before abbreviations of organizations in which each letter is said separately (the FBI, the FDA,
etc.). If we pronounce the organization as a word instead of saying each letter, we don’t use the article “the” (NASA,
FEMA, PETA, etc.). Fhe-NASA is doing some impressive things with nanotechnology. NASA is doing some
impressive things with nanotechnology. Many people are members of the-RPEFA, which is an organization that fights
for animal rights. Many people are members of PETA, which is an organization that fights for animal rights. FBlis a
powerful organization. The FBI is a powerful organization.

We need to use an article before professions in English (if it’s singular). +am-chef. |am a chef. Jandisarchitect. Jan
is an architect.

We say when someone was a child, not when-semeene-was-chid. | had blond hair when-hwas-ehild. | had blond hair
when | was a child. When she-was-child, she was very quiet. When she was a child, she was very quiet.

In general, when we talk about meals we don’t use the article “a” or “an.” However, if we include an adjective, then we
use the article “a” or “an.” Did you eat-a-breakfast-this morning? Did you eat breakfast this morning? | finish work
at five o’clock, and then I’'m going to go home and eatatuneh. 1 finish work at five o’clock, and then I’m going to go
home and eat lunch. | had-big-breakfast this morning. | had a big breakfast this morning. We’ve been eating a lot of
junk food lately, so let’s eat light-dinner. We’ve been eating a lot of junk food lately, so let’s eat a light dinner.
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Prepositions

We say depends on, not dependsof: I don’t know what I’m going to do tomorrow. It depends-of the weather. 1don’t
know what I’m going to do tomorrow. It depends on the weather.

We say think about/of, not think-+r-  I’'m thinking+r my future and deciding what | want to do. I’m thinking about my
future and deciding what | want to do. If we are imagining or envisioning something, we use think of or think about. If
we are considering something, we use think about.

We say married to, not married-with: He is married-with a woman from Argentina. He is married to a woman from
Argentina. With the verb “to marry” we don’t use a preposition. | marriedte my wife when | was 20 years old. They
married my wife when | was 20 years old.

We say worry about, not werry-fer- Her mother werriesfor-her a lot. Her mother worries about her a lot.

We say dream about, not dream-with: What does it mean if you dream-with-flying? What does it mean if you dream
about flying?

We say similar to, not simiarthanr- John is very simiarthan his older brother. John is very similar to his older
brother.

We say near or close to, but we don’t say rearte- The hotel I’'m staying at is nearte the airport. The hotel I’'m staying
at is near the airport. The hotel I’m staying at is close to the airport.

When we are talking about the creator of something we say written by, painted by, directed by, created by, etc.
not written-for, painted-for, etc. One Hundred Years of Solitude was writtenfor Gabriel Garcia Marquez. One
Hundred Years of Solitude was written by Gabriel Garcia Marquez. Clockwork Orange was directed-for-Stanley
Kubrick. Clockwork Orange was directed by Stanley Kubrick. Starry Night was painted-fer Vincent Van
Gogh. Starry Night was painted by Vincent Van Gogh.

We say related to, not related-with- This is a problem related-with drug abuse. This is a problem related to drug
abuse.

We say arrive in/at a place, not arrive-te-aplace: | arrivedto-werk at 9 AM. | arrived at work at 9 AM. We use
arrive in when we are talking about large places such as cities and states (London, the UK, New Jersey, etc.). We use
arrive at when we are talking about specific locations (the bank, the store, work, etc.).

We say go home, not go-to-heme: Instead of going-to-heme right after work, let’s go get something to eat. Instead of
going home right after work, let’s go get something to eat.

We say listen to + something/someone. Omitting the preposition “to” is incorrect. She wants to know what kind of
music you are Hstening. She wants to know what kind of music you are listening to. Can | borrow your notes? |
wasn’t Hsteping-the-teacher during class. Can I borrow your notes? I wasn’t listening to the teacher during class.
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We say good/bad at something, not geod/bad-in-semething: He’s-good-in-basketball but bad in baseball. He’s good at

basketball but bad at baseball. If we use the comparative and superlative forms of good and bad, the same rule
applies. He’s geod-in-basketbal, but he’s better-infootball. He’s good at basketball, but he’s better at football. No, |
don’t want to go golfing. I’'m the absolute werst-ir-golf: No, I don’t want to go golfing. I’m the absolute worst at golf.

We say opposite of, not eppesite-to: “Light” is the opposite-to “dark.” “Light” is the opposite of “dark.”

We say talking on the phone, not tatking-by-phene: Please be quiet. I'm tatking-by-phone. Please be quiet. I’'m talking
on the phone.

We say attend an event, not attend-te-an-event to communicate asistir a un evento. | have attended-to-every-single-class
this year. | have attended every single class this year.

With many verbs (answer, ask, call, choose, tell, visit), we don’t place “to” between the verb and the object. I couldn’t
answer-te the teacher. I couldn’t answer the teacher. The reported asked-te him a question. The reported asked him a
question. Salespeople always eat-te the house during dinner. Salespeople always call the house during dinner. |
hope they ehoese-te me for the job opening. | hope they choose me for the job opening. | teldte John the story about
what happened last weekend. 1 told John the story about what happened last weekend. There are other examples, but
the verbs above tend to cause problems for Spanish speakers.

We say been to, not been-in for cities, states, and other places. I’ve never been-n New Jersey. I’ve never been to New
Jersey. Before that, she had never been-ir Europe. Before that, she had never been to Europe. Have you guys been-in
that new Italian restaurant? Have you guys been to that new Italian restaurant?

We say smile at someone, not smileto-someene: A cute guy smiled-to-me on the bus. A cute guy smiled at me on the
bus.

We say despite + noun/gerund, not despite-of +houn/gerund. Despite-ofbeing tired, he came to class Despite being

tired, he came to class.

We say on the bus/train/plane, not in-the-bus/planeftratn:  Sometimes I read when I’'m #-the-bus. Sometimes | read
when I’m on the bus. Let’s get in-theplane. Let’s get on the plane. We use “on” with types of public transport and
“in” with cars, vans, trucks, etc.

We say waiting for someone/something, not waiting-sermeone/something: We are waitingJdohn to get here. We are

waiting for John to get here.

We say trust someone, not trust-in-semeone: | trust-in-my-employees to do a good job when I’m not in the office. |
trust my employees to do a good job when I’m not in the office.

We say according to someone, not accerding-someone. According-many-experts, the economy is going to

improve. According to many experts, the economy is going to improve.

If we are talking about completing paperwork (forms, government documents, etc.) we say fill out, not fi- |-filled-the
70



tmmigrationferm-when | was on the plane. | filled out the immigration form when I was on the plane.

We say put music on or put on music, not patmusie to communicate poner misica. Let’s-put-rausie. It’s too
quiet. Let’s put on some music. It’s too quiet. Let’s put some music on. It’s too quiet.

We say contact someone, not eentact-with-someone: 1’'m going to eentact-with-her when | find out more
information. I’'m going to contact her when | find out more information.

We say pay for something, not pay-semething to talk about purchasing something tangible. They paid-the-beek and
then left the store. They paid for the book and then left the store. When talking about something intangible (bills,

taxes, rent, etc.) we don’t use “for.” Everyone has to pay-fertheirtaxes by April 15th. Everyone has to pay their taxes
by April 15th.

We say the same as, not the-same-than or the-sameto. He’s the same-than his father. They both like the same things
and have similar personalities. He’s the same as his father. They both like the same things and have similar
personalities.

We say because of, not for to emphasize the cause or reason of something. I can’t go running right now-fer-my knee
injury. Ican’t go running right now because of my knee injury. Getting to work can be difficult fer the
traffic. Getting to work can be difficult because of the traffic.

We say insist that, not insistia-that:  She insisted-in-that we stay for dinner. She insisted that we stay for dinner.

We say in the world, not efthe-world to communicate del mundo. Lionel Messi is one of the best soccer players efthe
world. Lionel Messi is one of the best soccer players in the world.

Verb Choice

We use the verb to be for ages, not te-have: She has25-years: Sheis 25 yearsold. She’s twenty-five. Many
expressions with tener in Spanish take the verb to be in English. tener hambre is to be hungry tener miedo is to be
scared/afraid tener sed is to be thirsty tener suefio is to be tired tener verguenza is to be

ashamed/embarrassed tener frio is to be cold tener prisa is to be in a hurry tener razon is to be right tener la
culpa is to be guilty tener celos is to be jealous

We say make money or earn money, not gaitr-meney- | hope to get a new job soon so | can gain-mere-money- | hope
to get a new job soon so | can make/earn more money. Win money would also be incorrect. We use win money to talk
about prizes or gambling winnings.

We say make mistakes, not have-errers or have-mistakes: My English is okay, but | have-alet-oferrers: My English is
okay, but I-have-a-lot-ef-mistakes: My English is okay, but | make a lot of mistakes.

We say have a party, not make-a-party or dea-party= Do you think we should make-a-party this weekend? Do you
think we should de-a-party-this weekend? Do you think we should have a party this weekend?
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We say play a sport, not practice-a-sport if it is for fun or recreation. 1 like to practice-soecer with my friends after
work. | like to play soccer with my friends after work.

We say spend time, not share-time to communicate compartir tiempo. On the weekend, she usually shares-time with
her husband. On the weekend, she usually spends time with her husband.

We normally say go to a place, not visit-a-place. We typically use “visit” for people. | might visit-the-beach this
weekend. | might go to the beach this weekend.

We say take pills, not drirk-piHs. We only use “drink” for liquids. | always drink-apiH if | have a headache. | always
take a pill if I have a headache.

We say wear, not use to talk about clothes, jewelry, makeup, or anything else that goes on someone’s body. John is the

one using-thered-shirt. Tom is the one using-glasses. John is the one wearing the red shirt. Tom is the one wearing
glasses.

We say come in, not pass when we tell someone to enter a room. He knocked on the door, and I told him to pass: He
knocked on the door, and | told him to come in.

We say pay attention, not put-attentien: 1 don’t remember what they said. I wasa’tputtingattention. [ don’t remember
what they said. I wasn’t paying attention.

We say to take care of or to look after, not to care to communicate cuidar a alguien. Jessica eares her little brother
when her mom is at work. Jessica takes care of her little brother when her mom is at work. Jessica looks after her
little brother when her mom is at work.

We say support, not maintain to communicate mantener a alguien. It’s really difficult to maintain three kids. It’s
really difficult to support three kids.

We say tell the truth, not say the truth. They were such honest kids. They always said-the-truth: They were such
honest kids. They always told the truth.

We say to go for the first time, not te-meet or te-knew to communicate conocer un lugar. We only use “meet” for
people. | met-New-Yeork in 2009. | went to New York for the first time in 2009.

We say see, visit, experience, etc. for places, not knew. Let’s leave the hotel so we can khow-thecity. Let’s leave the
hotel so we can see/experience/check out the city.

We say pay, not eancel to talk about making a payment. Can you go up to the counter and eareel? Can you go up to
the counter and pay?

We say lead, not eenduet to communicate ensefiar el camino or conducir a un lugar. They eonducted-the horses to the
stable. They led the horses to the stable. (lead becomes led in the past.)
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We say waste time, not fese-time to communicate perder el tiempo. Sara feses-a lot of time watching TV. Sara wastes
a lot of time watching TV.

We say brush (someone’s) teeth, not wash-(semeone’s)-teeth. [’'m going to wash-rmy-teeth and go to bed. I’'m going
to brush my teeth and go to bed.

We say keep a secret, not save-a-seeret or guard-aseeret.  You can tell me what’s bothering you. I can save-a
seeret:  You can tell me what’s bother you. I can guard-a-seeret:  You can tell me what’s bothering you. I can keep a
secret.

We use the verb turn out, not result to communicate resultar que. It results-that we are both from the same town. It
turns out that we are both from the same town.

We say to sunbathe or to get a tan, not to take sun. I’m going to take-sun today. ’m going to sunbathe today. I’'m
going to get a tan today.

We almost always say hire, not eentract-to communicate contratar a alguien. Things have been going really well.
Management is thinking about eentracting more people. Things have been going really well. Management is thinking
about hiring more people.

We say take place, not have-place to talk about where events happen in a movie, book, play, etc. The novel-has-plaee-in
Brooklyn in the 1920’s. The novel takes place in Brooklyn in the 1920’s.

Animals lay eggs. They do not puteggs: Our chicken still hasn’t put-any-eggs-this week. Our chicken still hasn’t laid
any eggs this week. (lay is laid in the past)

We say make (someone/something) disappear, not disappear{someone/semething). Joseph Stalin disappeared-many
people when he was the leader of the Soviet Union. Joseph Stalin made many people disappear when he was the leader
of the Soviet Union.

Verb Tense

We use the present continuous, not the simple present to talk about things happening en el momento. Right now, +eeok
dinner. Right now, I'm cooking dinner.

We don’t use the structure-aybe-+-goinrg-te—+verb. We use maybe + subject + will or might instead. Maybe-we-are
goetng to the beach this weekend. Maybe we’ll go to the beach this weekend. (the speaker is thinking about it now) We

might go to the beach this weekend. (the speaker is communicating a future possibility)

We use one of the present perfect tenses, not the simple present to talk about actions that started in the past and continue
in the present. He-has-three-years at this company. He has worked here for three years. He has been working here
for three years. Hew-leng-do-they-have being married? How long have they been married?

We use will, not geing-te when we make a decision about the future at the same time we are speaking. Your car broke
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down? No problem, Pm-geingto-pickyouup at your house. Your car broke down? No problem, I'll pick you up at

your house. Would you like a copy of this presentation? Okay, my-seeretary-is-going-to-send-it to you. Would you
like a copy of this presentation? Okay, my secretary will send it to you.

In Spanish, some verbs are followed by “que” and then the second verb in the subjunctive. Quiero que

tenga... Quisiera que me regale... Espero que tenga... Le pedi que llegaran... In English, these verbs (want, would
like, expect, ask, and tell) are followed by the object and the second verb in the infinitive. | wantthat-you-cal me

later. | wantyou to call me later. | would-like-thatyou-help me with something. | would like you to help me with

something. They always expected-that-we-were on time. They always expected us to be on time. He asked-thatt-get
here at 8 AM. He asked me to get here at 8 AM. He teld-thattget here at 8 AM. He told me to get here at 8 AM.

When we put two verbs together, some verbs are followed by the infinitive and some verbs are followed by the
gerund. A common mistake is to always combine two verbs by putting the second verb in the infinitive. | aveid-to-go
to the mall on weekends. | avoid going to the mall on weekends. She enjeyste+ur. She enjoys running. Verbs
followed by the gerund include avoid, consider, deny, enjoy, finish, keep, miss, recommend, suggest, and understand.

Noun Choice

We have the words main and principal in English. With many nouns, main is a better choice and principal can sound
awkward. The principalpreblem is a lack of data. The main problem is a lack of data.

We usually say flood, not inundatien: After the storm, there was an irundation-in the valley. After the storm, there
was a flood in the valley.

We say parking lot, not parking to talk about a specially designed area in which to park cars. The parking-was full, so
we parked on the street. The parking lot was full, so we parked on the street.

We say permit, not permissien to talk about an official document that gives us permission to do something. We had to
show the government officials our permissionr. We had to show the government officials our permit.

Only married people have a mother-in-law, father-in-law, etc. Paul likes his girlfriend a lot, but he doesn’t like his
mother-in-law-  Paul likes his girlfriend a lot, but he doesn’t like his girlfriend’s mother.

We say coworkers, not partrers to talk about the people we work with. We say classmates, not partrers to talk about
the people we go to school with. 1It’s hard to get work done because my partrers-talk too much. It’s hard to get work
done because my coworkers talk too much. Brandon’s high school partrers-always made fun of him. Brandon’s high
school classmates always made fun of him.

Most Spanish words ending in “ion” have an equivalent in English. However, some do not. actualizacion is
update, not actuakization calificacion can be grade, mark, score, or rating, not ealification explicacion is
explanation, not exphication grabacion is recording, not grabatien decepcion is
disappointment, not deception (“Deception”= engafio, see section on false friends) filmacion is filming or
shooting, not filmatien habitacion is room or bedroom, not habitatien presion is
pressure, not pressien recopilacion can be collection, set, summary, review, or compilation,
not recopitation ubicacion is location, not ubication
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Plural Nouns

Hemewaorks is not a word. Homework is a non-count noun. Kate couldn’t come to the party because she had many
homewerks-to do. Kate couldn’t come to the party because she had a lot of homework to do. (or too much homework to
do)

Furtnitures is not a word. Furniture is a non-count noun. We just bought a house and we have to buy new
furtnitures.  We just bought a house and we have to buy new furniture.

Adviees is not the plural of advice. Advice is a non-count noun. My father always gave me very good aeviees. My
father always gave me very good advice.

Popeerns-is not a word. Popcorn is a hon-count noun. Let’s make some pepeeras-and watch a movie. Let’s make
some popcorn and watch a movie.

Evidenees is not the plural of evidence. Evidence is a non-count noun. There were many-evidences against the
defendant. He was convicted of the crime. There was a lot of evidence against the defendant. He was convicted of the
crime.

Proefs is not the plural of proof. Unless we’re speaking about mathematical proofs, proof is a non-count noun. He had
to provide preefs-of his legal status in the country. He had to provide proof of his legal status in the country.

Jewelry is normally a non-count noun. Her husband has given her manyjewelries-over the years. Her husband has
given her a lot of jewelry over the years.

We say election, not electiens to talk about one event. The next presidential elections-will be in 2018. The next
presidential election will be in 2018. We say elections to talk about multiple events.

We say go on vacation or take a vacation, not te-ge-on-vacations or take-vacations: I’'m going to take-vacations next
May. I’m going to take a vacation next May. Stewart is en-vacations: He’ll be back on Monday. Stewart is on
vacation. He’ll be back on Monday. We say vacations to talk about multiple trips on multiple occasions.

News is always plural (except to communicate nuevo). Have you heard the rew-about Stacy? Have you heard the
news about Stacy?

Scissors is always plural. Pass me the scisser, please. Pass me the scissors, please.

Pajamas is always plural. My son opened his Christmas presents without changing out of his pajama. My son opened
his Christmas presents without changing out of his pajamas.

To talk about multiple people in a family, we add an “s” to the last name. FheThempsen-live next tous. The

75



Thompsons live next to us. She likes to watch-the-Simpsen. She likes to watch the Simpsons.

Words like candy, chocolate, and beer are both count and non-count nouns. We use the singular form to talk about
something abstract and the plural form to talk about a specific number. He eats tee-any-candies. He eats too much
candy. They ate-12choeolate. They ate 12 chocolates. He’s probably going to get up late tomorrow. He drank-a-let
of-beers last night. He’s probably going to get up late tomorrow. He drank a lot of beer last night. He drank six-beer
last night. He drank six beers last night.

Adjectives

Fun and funny are two different adjectives with different meanings. Fun = something enjoyable (divertido) Funny =
something that causes laughter (chistoso) Playing video games is fuany.  Playing video games is fun. My friend
Frank always makes me laugh with his fun-stories. My friend Frank always makes me laugh with his funny

stories. The comparative of fun is more fun, not funrer | think going dancing is furnerthan staying home. | think
going dancing is more fun that staying at home.

We only use ugly to describe the physical appearance of something. You were ughy with me yesterday. You were
mean to me yesterday. |had a very ughrday. | had a very bad day.

We normally use humble to talk about people, not things. He has a lot of money, but his house is very humble He has
a lot of money, but his house isn’t very big. He has a lot of money, but his house is very modest.

We say that people are close, not united-to communicate son muy unidos. Kate and her father are very united. She calls
him every day. Kate and her father are very close. She calls him every day.
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COLLOCATION

What is a collocation?

A collocation is two or more words that often go together. These combinations just sound "right" to native English
speakers, who use them all the time. On the other hand, other combinations may be unnatural and just sound "wrong".
Look at these examples:

natural English... unnatural English...
the fast train the guiek train

fast food guiek food

a quick shower a fast shower

a quick meal a fast meal

Why learn collocations?

o Your language will be more natural and more easily understood.
o You will have alternative and richer ways of expressing yourself.
It is easier for our brains to remember and use language in chunks or blocks rather than as single words.

brand awareness business model
Noun-Noun Collocations brand identity business partner
advertising agency brand name business people
advertising campaign brand recognition business plan
age discrimination budget increase business trip
balance sheet budget reduction company policy
bank loan budget surplus conference call

benefits package business ethics conference room



cost reduction trade secrets consider the fact

customer base web page consider the possibility
customer satisfaction consider the risk
customer service Verb-Noun Collocations cut costs

employee benefits accept an apology deliver an order
government regulation accept a job develop a strategy
human resources accept a meeting request exchange ideas

interest rates
labor market
labor union
market leader
market share
mission statement
operating costs
performance review
price controls
price range

price tag

price war

product launch
product line
product placement
profit margin
sales figures

sales team

stock exchange
stock market
stock options

time management

accept an offer
accept a position
accept responsibility
admit fault

admit a mistake
apply pressure
attract investors
boost confidence
borrow money
break a law

break into a market
build trust
calculate risk

call attention
cancel a meeting
cancel an order
chair a meeting
change one’s mind
choose sides

close a deal
complete a task

confirm suspicion

exchange a product
fire someone

fix a problem

gain access

gain experience
gain ground

gain knowledge
hire staff

invest money
invest resources
invest time

join forces

join an organization

join a union

keep someone’s word

launch a product
lend a hand

lend money

lower prices
lower taxes
manage a business

manage a company
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manage a store
manage stress
measure progress
meet criteria

meet a deadline
open an account
pay attention

pay bills

pay dividends

pay a fee

pay an invoice
pay taxes

place an order
present a problem
provide assistance
provide support
raise awareness
raise money

raise an objection
raise prices

raise questions
raise taxes

reach an agreement
reach a compromise
reach a consensus
reach a decision
reach a point
recall a product

receive compensation

receive a discount
receive payment
run a business
save money
save time

sell a business
sell shares

send a copy
send a message
send a letter
sign a contract
take out a loan
waive a fee
waste time
waste money
write an email
write a letter

write a note

Collocations with Make
make an appointment
make an attempt

make a change

make a choice

make a comparison
make a complaint

make a connection

make a decision

make a demand

make a difference
make an effort

make ends meet
make an exception
make an excuse

make a fortune

make a living

make a mistake

make money

make an offer

make payments

make plans

make a point

make a profit

make progress

make a promise

make a request

make sense

make something clear
make a suggestion
make sure

make a telephone call
make the best of something
make the most of something

make time

Collocations with Do
do business

do a crime
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do damage

do an experiment
do a favor

do good/bad

do harm

do research

do right/wrong
do something/anything
do well

do your best

do your duty

do your part

do your share

Collocations with Take
take advantage

take a course

take notes

take action

take a break

take a decision (British, make a
decision in American English)

take a message
take part in

take responsibility
take a test/quiz

take your time

Collocations with Have

have an appointment

have an argument

have a conversation

have a meeting

have problems

have a talk

have time

have trouble

have coffee/tea

have breakfast/lunch/dinner

have work

Collocations with Get
getajob

get a certification

get angry

get better/worse

get excited

get going

get the message

get motivated

get paid

get permission

get ready

get somewhere/nowhere
get started

get used to

Collocations with Go

go ahead

go bankrupt

go forward

go home

go out of business
go to work

go well

Collocations with Prepositions
accused of

adapt to

agree on something
agree with someone
apply for

approve of

argue about something
argue with someone
aware of

believe in

blame for

by accident

by mistake

cause of

comment on

complain about
concentrating on
consist of

contributed to

counton
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credit for

decide on
decrease/increase in
demand for
depend on

fear of

from scratch
good at
graduate from

in charge of
insisted on
matter to

object to

on purpose
participate in
pay for (something)
plan for

plan on

prepare for
proud of

reason for
relationship with
reply to

respond to
responsible for
return to
satisfied with
smile at

take advantage of

tax on

trouble with

Collocations with in
believe in

in a car/taxi

in a fight/argument
in a group

in advance

in charge

in conclusion

in control

in denial

in depth

in detail

in private

in return for

in the mail

in the process of
in trouble
Interested in
involved in

participate in

Collocations with on

ban on something

blame something on someone
decide on

depends on

focus on

on a committee

on a plane/bus/train
on a team

on average

on call

on display

on duty

On one hand.../On the other
hand...

on purpose
on sale

on someone’s side
on the phone

on the radio

rely on
restrictions on

vote on

Adjective-Noun Collocations
big break

big chance

big decision

big disappointment

big improvement

big mistake

big surprise

bright future

competitive advantage
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daily commute
daily routine
deep thought
deep trouble
false advertising
friendly reminder
good faith

good news

good time

golden opportunity
great admiration
in great detail
gray area

great pride

great respect
great skill

harsh criticism
heated debate
heavy rain

heavy traffic
hidden agenda
high/low costs
high/low degree
high/low level
high/low price
high/low profile
high/low quality
high/low standards

high/low risk

high salary
honest answer
hot topic

huge loss

huge problem
immediate impact
large amount
large number of
large quantity
perfect example
positive attitude
private sector
public sector
raw materials
rising costs
slight chance
sound advice
stiff competition
straight answer
strong belief
strong feeling
strong opinion
top priority

wise choice
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Collocations Exercises

Collocations are word combinations that sound natural to native speakers. For example, pay attention is a
collocation, but put attention isn’t. Using correct collocations will make your English sound more
natural. Test your knowledge of collocations by trying the exercises below. Also try these advanced
collocations exercises.

Adjective-Noun and Adjective-Adverb Collocations

Choose the adjective or adverb that collocates with the words in green. The questions will be displayed in a
random order every time the quiz is taken.

Question 1 of 30 | was expecting a brief overview, so | was surprised when they went into everything in
__ detail.

deep
utter
great
thorough

Verb-Noun Collocations

Fill in the blanks with a verb that forms a collocation with the noun in green. You will need to conjugate the
verbs, and in some cases, you may need to use a phrasal verb (e.g. “fill out,” “take off,” etc.). The questions
will be displayed in a random order every time the quiz is taken.

He us a story about how he met his wife.

Preposition Collocations

Fill in the blanks with a preposition that forms a collocation with the word(s) in green. The questions will be
displayed in a random order every time the quiz is taken.

Our success depends ____ hiring the right people.

In and On Collocations

Fill in the blanks with either “in” or “on” to form a collocation with the word(s) in green. The questions will
be displayed in a random order every time the quiz is taken.
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I think he might be __ denial about what happened.

Make and Do Collocations

Choose the correct form of “make” or “do” to form a collocation with the word(s) in green. The questions
will be displayed in a random order every time the quiz is taken.
I’m not a fortune, but I’m content with my salary.

making

doing

Mixed Collocations

Choose the option word that forms a natural-sounding collocation with the word(s) in bold. Please note that
the questions are displayed in a random order every time the quiz is taken.

Mark told me that he hoped that we weren’t sacrificing quality for quantity.

in good faith
deeply
frankly

sincerely

Choose the option that forms a natural-sounding collocation with the word(s) in bold. The questions will
be displayed in a random order every time the quiz is taken.

You should talk to Human Resources to try to this dispute.

untangle
clear up
solve

settle
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SIGNPOSTS FOR PRESENTATIONS

Signposts are words or phrases that guide the listener during a presentation. They let the listener know what has
happened so far, and what is going to happen next. Below is a guide for using signposts during a presentation. Itis
divided into three sections: signposts for the introduction of a presentation, signposts for the middle of a presentation,
and signposts for the conclusion of a presentation. The first column contains signposts for a formal presentation, and
the second column contains signposts for an informal presentation.

Signposts for the Introduction of a Presentation

Introducing yourself:

Introducing the topic:

Outlining your
presentation:

Inviting questions:

Formal

*Good morning/afternoon/evening. On
behalf of (company, department, etc.), [’d
like to welcome you.

My name is (name) and | am (position).
*[’m going to give you an overview of...

*The focus of today’s presentation is...

*The presentation today is divided into
three parts. First, I’ll... Following that
I’ll... Finally, I'11...

*Please don’t hesitate to interrupt me if
you have any questions.

Signposts for the Middle of a Presentation

Introducing the first
section of your
presentation:

Finishing a section
and starting a new
one:

Expanding or

Formal

*[’d like to start/begin by...

*Well, we’ve looked at... Now, I’d like to
discuss...

*Having discussed... I’d like to move on

to....

*I’d like to expand more on...

Informal

*Hi everyone, I’m (name and title). Thanks for
coming.

*[’m going to talk to you about...
*[’m going to be talking a little bit about...
*I’m here today to talk to you about...

*[’m going to talk about three things today. Il
start with ... Then I’1l talk a little bit about ...
I’ll finish with...

*If you have any questions during the
presentation, please ask.

Informal

Let’s start/begin by looking at...

*Well, I’ve told you about... Now I’ll move
on to...

*Well, we’ve looked at.... Now, let’s talk
about....

*So, that was....Now, let’s...

*Let me tell you a little more about...
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elaborating: *I’d like to elaborate a little... *Let me give you some more

_ o ) details/information....
*Let’s consider this is more detail.

Talking about earlier r: r
or later points in your

presentation: 1ll elaborate on this later in the presentation. >re on this later.

provide you with a more detailed 1 going to talk more about this later.
lanation later in the presentation. )

ier:
ier: '

you remember [ said..?

repeat what I said earlier... ) '
I said earlier...

I mentioned earlier. ..

Recognizing your *As you may be aware of... *You might already know that...

listeners' prior

knowledge: *As you may know... *[’m sure a lot of you know that...
*] know many of you are familiar with... *I’m sure a lot of you know about...

*[’m sure a lot of you have heard...

Focusing audience's *May I focus your attention on the... You  <Take a look at this slide/chart/graphic etc.
attention on visuals: will notice that. .. You can see that...

*Please direct your attention to the *Okay, here we can see that...
slide/chart/etc.

Signposts for the Conclusion of a Presentation

Formal Informal
Summarizing and *Finally, let’s summarize some of the main  <Let’s summarize/recap what we looked at
concluding the points... today.
presentation: . . )
*To conclude, I’d like to summarize... Finally, let’s look back at what we covered
today.

*So, to remind you of what we looked at...

Inviting final *Does anyone have any questions or *Does anyone have any final questions?

guestions: comments before we conclude today? '
*Okay, does anyone have any questions or

*If you’d like me to elaborate or clarify comments?
anything we covered today, please ask.

Responding to tough a question you don’t have the answer to: a question you don’t have the answer to:

questions: ) ) . )
] want to answer your question ] don’t have that information with me. Can
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Finishing and saying
goodbye:

completely, but I don’t have all the
information with me right now. Could you
give me your email after the presentation so
I can send you a complete response?

a question you didn’t understand:
*Could you repeat that, please?
*Could you rephrase that, please?

*Let me make sure I understand you
completely. Do you mean that...?

oIf there are no further questions, I’d like to
thank you very much for your attention. If
you think of any additional questions,
please feel free to contact me.

you give me your email and I’ll send you an
answer later today?

a question you didn’t understand:
*Could/Can you repeat that, please?
*] didn’t catch that. Can you repeat it?

*Are you saying that...?

*Well, I think that’s about it. Thanks for
listening. Please contact me later if you have
any additional questions or want more
information.
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CONCISE WRITING EXERCISES

Good business writing is concise, direct, and unambiguous. The exercises below will help you eliminate

wordiness in your writing. Before trying the exercises, it may be helpful to read these tips.

Exercise 1

Make the wordy sentences more concise. The potential answers are listed after the activity.

1. In spite of the fact that our budget for advertising is now higher, our sales figures have not gotten any better.

2. In the event of an emergency, such as a fire or earthquake, please exit the building as soon as you possibly can.
3. We currently have several available job openings for a variety of positions in our Sales department.

4. The reason I’'m having trouble with my computer is because the antivirus has not been updated at all recently.
5. We consider the candidate to be a very good fit for either of the two positions.

6. As we discussed during our previous phone call, the shipping charges on your next order with us will be
waived.

7. We are now in the process of evaluating how to address the issue that exists regarding the performance of our
team members.

8. Our researchers carried out interviews with several people who are professionals in the health care industry.
9. Please change the information on your employee profile to include the most recent information.

10. We would like to offer congratulations to all the people who participated in and completed the training
program.

Potential Answers

1. Despite increasing our advertising budget, sales have not improved.

2. In case of emergency, please exit the building immediately.

3. We have several job openings in our Sales department.

4. I’'m having trouble with my computer because its antivirus is out of date.

5. We think the candidate would be a good fit for either position.
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6. As we discussed, we will waive the shipping charges on your next order.
7. We are addressing our team’s performance issues.

8. Our researchers interviewed several health care professionals.

9. Please update your employee profile.

10. Congratulations to everyone who completed the training program.

Exercise 2

Make the wordy sentences more concise. The potential answers are listed after the activity.

1. We certainly hope this decision won’t have a negative impact on the reputation of our firm.

2. Basically, what the training program is going to do is prepare each and every one of the participants for their
certification test that they will take soon.

3. Could you recommend to us someone in the area who works as a contractor?

4. There is a possibility that | might get together with some of the people in my MBA program this weekend.

5. She is professional, courteous, and she always comes to work on time.

6. The problem was addressed at our meeting that we have every week.

7. Please talk to John and tell him about the benefits of the deal and that he should accept it.

8. The primary role of our recruiters is to search for and locate professionals with good qualifications who live in
our area.

9. Carlos speaks English fluently, and can also speak Portuguese at an intermediate level, and in addition he is
capable of conversing in German.

10. It’s a really excellent opportunity and one that you should definitely take advantage of.

Potential Answers

1. We hope the decision won’t damage our reputation.
2. The training program will prepare the participants for the upcoming certification test.

3. Could you recommend a local contractor?
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4. | might get together with my MBA classmates this weekend.

5. She is professional, courteous, and punctual.

6. We addressed the problem at our weekly meeting.

7. Please try to persuade John to accept the deal.

8. Our recruiters find highly qualified professionals in our area.

9. Carlos speaks fluent English, intermediate Portuguese, and conversational German.

10. You should take advantage of this excellent opportuni
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BUSINESS ACRONYMS

Below is a list of the most common business acronyms that are used at the work place. Some of these
are actually used when sending emails or on memorandums.

Learn English Today: http://www.learn-english-today.com/business-english/abbreviations-
acronyms.html

Word Meaning
@ at
alc account
AGM annual general meeting
a.m. ante meridiem (before noon)
alo account of (on behalf of)
AOB any other business
ASAP as soon as possible
ATM automated teller machine (cash dispenser)
attn for the attention of
approx approximately
cc copy to
CEO chief executive officer
clo care of (on letters: at the address of)
Co company
cm centimetre
COD cash on delivery
dept department
e.g. exempli gratia (for example)
EGM extraordinary general meeting
ETA estimated time of arrival
etc et caetera (and so on)
GDP gross domestic product
GNP gross national product
GMT Greenwich mean time (time in London)
i.e. id est (meaning : 'that is’)
Inc incorporated
10U | owe you
IPO initial public offer
Jr junior
K thousand
Ib pound (weight)
£ pound (money/currency)
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This is a list of work-related acronyms that always provides an instant, pithy advice on a wide range of business
and work situations. These acronyms are virtually checklists for all kinds of purposes.

ABC
Always Be Closing. Traditional selling process acronym which emphasizes the need to be continually moving the
customer towards action and agreement within sales discussions

APE
Attentive, Peripheral, Empathic. The three main types of listening. Empathic listening is the skill of understanding
meaning and motive in another's words, a considerably powerful ability.

ALF
Always Listen First. Obviously great for training sessions generally, also counseling, customer service, selling,
etc, and relationships overall.

AIDA
Attention, Interest, Desire, Action.

ADDIE
Analysis, Design, Development, Implementation, Evaluation. The process of innovation, any field at all.

BEER

Behavior, Effect, Expectation, Results. The headings by which to assess performance of anything, particularly a
new initiative. A great discipline when working with a team or delegating another to conduct a review, when it's
important to keep the review focused.

BENDWIMP
Beliefs, Evidence, Needs, Desires, Wounds, Interests, Mentors, Proud of. A model, typically used as a table or
template or matrix for identifying motivations and issues of stakeholders within a project plan.

BHAG
Big Hairy-Assed Goal.

BID

Break It Down. When training anything to anybody never teach the whole thing all at once. Break the skill or
process down to digestible parts. This will avoid destroying confidence, and enable gradual progress to the point
that the whole thing can be practiced.

BOOSTER
Balanced, Observed, Objective, Specific, Timely, Enhancing, Relevant. Useful acronym for coaching and giving
feedback to people. If anyone knows the origins please tell me.

BOSCARDET

Background, Objectives, Scope, Constraints, Assumptions, Reporting, Dependencies, Estimates, Timescales.
Very useful acronym for inception of projects, committees, investigations (inquiries), studies, reports, etc, where
purpose, parameters and ground-rules etc., have to be established.

CLAMPS
Challenge, Location, Advancement, Money, Pride (or Prestige), Security. Employment and recruitment industry
acronym: the six acceptable reasons for leaving your job if asked why in a job interview.

DIKWIAD?
Do | Know What I Am Doing? Useful reminder to check readiness before starting anything which might cause
problems if under-prepared.

DREAM
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Dedication, Responsibility, Education, Attitude, Motivation. The DREAM acronym seems to feature particularly
on rubber wrist bands,

EDIP
Explain, Demonstrate, Imitate, Practice.
A simple teaching and learning model.

GOSPA
Goals, Objectives, Strategies, Plans, Activities. A simple blueprint and order of thinking for business planning of
any sort, even for large complex challenges and entire businesses.

GROW

Goals, Reality, Options, Will. A maxim from the life-coaching industry, which makes a lot of sense, and is
relevant to any situation that requires realistic objectives to be established, and then the planning and
determination to achieve them.

IDEA

Identify, Design, Execute, Augment. Process for changing anything. Identify the issues, priorities, constraints,
resources; Design the plan; Execute the plan; Augment, refine, adjust and improve activities to consolidate
change.

IDEAL

Identify, Define, Explore, Action, Lookback. Process for solving problems: Identify the problem, Define it,
Explore possible solutions and effects, Action the chosen solution, and Look back at the SNAFU you've brought
about (not really - Look back at a 100% successful outcome and a job well done).

IMCIS

Identify, Manage, Change, Improve, Show. The basis of the Japanese approach to TQM, as in: Identify customer-
supplier relationships, Manage processes, Change culture, Improve communications, Show commitment.
(Acknowledgments to John Oakland.)

IMHO
In My Humble Opinion. Often used in web-messaging, emails and texting.

KISS

Keep It Simple Stupid. One of the all time great acronyms, and so true. A motto and reminder that simplicity
works - in communications, design, philosophy, relationships, decision-making, meetings, management and life
generally. Apply and promote KISS to any situation to deter unnecessary complication, excuses, bureaucracy,
red-tape, and to encourage practical positive outcomes, no-nonsense communications, integrity, truth, beauty, and
honesty. Variations on the KISS theme include Keep It Short and Sweet, Keep It Simple Sunshine, Keep It
Simple and Straightforward, Keep It Simple Sister, Keep It Simple Sweetheart, etc.

LEAR

Listen, Empathies, Ask, Resolve.

A fine mnemonic for customer service and other problem-solving communications. Here is more detail of the
model represented by the LEAR acronym:

Listen - You must show serious and honest concern for the customer seriously, which you will begin to do by
listening. By listening actively you also take the first step towards diffusing customer upset or anger.

Empathies - Put yourself in the customer's shoes and see the situation from their perspective. Showing genuine
concern and understanding is vital for empathy. Understanding is not necessarily the same as agreeing, which can
be important where the issue needs investigating before finally resolving.

Ask - Ask Questions: ask open questions (what, how, etc) to diagnose the situation or request, and never attempt
to interrupt, or justify your point or argue. The customer is not interested in your point of view - the other person
wants you to understand them, not present a defense or a counter-argument.

Resolve - Resolve the problem to the customer's satisfaction as quickly as possible. Consider the value of the
customer and not the cost of resolving this particular issue.
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LEDO

Listen, Empathies, De-personalize, Offer. Mainly for customer service, and also good for any conciliation or
conflict resolution: listen to the complaint, empathize with the customer, de-personalize the situation (both of you
stand back and look at it objectively), and then offer a solution. Brilliant and simple.

MMM or 3M

Measurable, Manageable, Motivational. A great tri-pod or three-legged stool analogy - the three essential struts
for any contracted arrangement or understanding, or delegated task. Remove any of the three legs and the
structure falls over. Alternatively: Mrs, Mother, Martyr, with an optional fourth M for Mistress if appropriate.

MOFMOF

Minimum Of Fuss, Maximum Of Flavour. The MOFMOF maxim is extremely transferable to work, management,
business, and to life generally, since it essentially emphasises the concept of focusing your effort on what matters
most. 'Minimum of Fuss' equates to minimum effort, investment, time, resources, etc. 'Maximum of Flavour'
equates to maximum return, result, reward or effect, etc. This is the secret of productivity, sustainable success,
and effectiveness in all fields, not just cooking, and is one of the most widely neglected simple rules of achieving
anything.

MBWA

Management By Walking About (or Wandering Around). Depending on who is doing the walking about and
whether you are in the vicinity this could be either a good thing or a bad thing. If you are a manager and like to
manage by walking about make sure you do it with humility and genuine interest. Better still why not actually do
the job on the factory floor for a week and you'll really find out what's going on. Indirectly referred to as the 'HP
Way'.

MBWAL
Management By Wandering Around and Listening. Extension of the MBWA management technique.

MEGO
My Eyes Glazed Over. Watch for this sign from your audience at your next presentation. If spotted you could need
more acronyms.... See PEARL and LANO also.

MELVIN

Mediocrity, Ego, Limits, Vanity, Incompetence, Name-calling. Non-productive aspects of workplace behavior and
attitude. Various MELVIN terms (eg 'NO MELVIN', 'Don't be a MELVIN', 'No MELVIN's here', etc) help
remind people of the behaviors to avoid, especially in blame cultures or negative-thinking environments. (Ack P
Lubbers) Sits well alongside other motivational and positive attitude maxims, many examples on the quotes and
leadership sections, and links well with the philosophies of Covey's seven habits, Carter-Scott's rules of life and
Ruiz's Four Agreements.

MILE

Maximum Impact, Little Effort. Acronym to express the principle of optimizing productivity, and the value of
identifying 'high-yield' areas on which to apply 'high-yield' methods and techniques. Especially helpful in sales
and marketing training. See also PAY and MOFMOF.

MBA

Master of Business Administration. Not everyone knows what this actually stands for, and when you think about
it, 'Master of Business Administration' arguably gives a somewhat lop-sided impression of what modern business
management is all about. Too late to change it now though..

MBO (or MBQO's)
Management By Objectives. The classic management, delegation and development technique, but which people's
activities and aims - and the coaching support given - can be geared to organizational targets and priorities.

4P (also PPPP)
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Piss-Poor Prior Planning. Military abbreviation

POSTAD TV

Priorities, Outcomes, Sequence, Timings, Attendees, Date, Time, Venue. Nothing to do with Eastern Bloc
broadcasting, these are the essentials for a good meeting, and what must appear on the agenda. (‘Outcomes'
meaning required outcomes, i.e. discussion, decision, etc.)

PRIC

Problem, Rectification, Investigation, Correction. Known as the corrective action loop. The essential four stages
for good quality management practice, customer service development, quality of service, and general personal
development. The main point is that rectifying the problem is only half the story; you need to ensure there is no
recurrence.

PEST

Political, Economic, Social, Technological. Classic situational analysis headings, guaranteed to prompt nods of
approval when used in business presentations. You may see 'Environmental’ used instead of 'Economic' depending
on the context. Either version is actually a very useful analysis and interpretation tool for business and marketing
situations. PEST is sometimes extended to 'PESTELI'" in which the headings: Ecological (or Environmental),
Legislative (or Legal), and Industry Analysis are added.

PEP
Paternalistic, Economic, Participative. The three main motivational styles found in organizations and
management.

PRIDE
Personal Responsibility In Delivering Excellence.

RTQ2

Read The Question Twice. A very useful reminder for text-based exams of all sorts, notably multiple choice tests,
to help avoid making silly mistakes when the answer is known but given incorrectly due to rushing and
misreading the question. (Thanks D Ward)

SMART

Specific, Measurable, Agreed, Realistic, Time-bound. If you're setting a standard, or an objective for yourself, or
agreeing an objective with another person, the task or standard must meet these criteria to be effective. Other
interpretations of the SMART acronym exist, for example Specific, Measurable, Achievable, Relevant, Time-
bound. The version which includes 'agreed' is arguably more powerful because this represents the emotional
contract with whomever is expected to meet the objective or standard. The SMARTER version below is more
powerful and relevant for the modern world because it includes the essential philosophical aspect. Avoid
interpretations that include both Achievable and Realistic because the words effectively mean the same so is a
waste of a word.

SMARTER

Specific, Measurable, Agreed, Realistic, Time-bound, Ethical, Recorded. The deluxe version of the SMART
acronym, a blueprint for all objectives and responsibilities, especially delegation, for oneself or when agreeing
objectives, tasks and projects with others. Traditional interpretations of the SMARTER acronym use 'Exciting' or
‘Enjoyable’ instead of 'Ethical’, but in a delegation context, let's face it, it is not always possible to ensure that all
delegated work is 'exciting' for the recipient. Whereas the 'Ethical’ aspect is fundamentally important for
everything that we do, assuming you subscribe to such philosophy.

SLEPT

Social, Legal, Economic, Political, Technological. 'SLEPT analysis' is a business review method similar to PEST
or SWOT for assessing factors enabling or obstructing the business's performance, and typically its development
potential.

7S
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Skills, Strategy, Structure, Style, Systems, Staff, Shared values. The McKinsey organization’s famous 7S model
for organizational culture, analysis and development. The idea is that the first six S's combine to form the seventh:
'shared values'

SONTTAP

Say Only Nice Things To All People.

Devised originally for school-children, this acronym touches on a fundamental principle for peace of mind and a
happy fulfilled life.

SPIN®
Situation, Problem, Implication, Need. One of the most enduring selling acronyms.

SOSTAC®
Situation analysis, Objectives, Strategy, Tactics, Action, Control. SOSTAC® is a business marketing planning
system developed by writer and speaker PR Smith in the 1990s.

SQ3R

Survey, Question, Read, Recall, Review. Impossible to pronounce, but nevertheless a great discipline for the
learning-through-reading process. It basically means quickly Survey the whole thing (ie look but not in detail),
next note down your Question areas, then Read it in detail, Recall your questions and Review the material you've
read.

STEPPPA

Subject, Target, Emotion, Perception, Plan, Pace, Adapt/Act. The STEPPPA acronym represents a coaching
(notably life-coaching in a business context) model devised and advocated by expert coach Angus McLeod. T he
STEPPPA process entails:

Subject - validate the subject (the issue or matter) for the person being coached (coachee).

Target - validate or help to establish the specific target (or goal) of the coachee - called target identification.
Emotion - ensure emotion is addressed and resolved relating to the coachee, the issue, and the target, which if
appropriate should be re-evaluated.

Perception - widen the perception and choice in the mind of the coachee.

Plan - help the coachee establish a clear plan (process with steps, not choices).

Pace - include pace (timescale and milestones) in the plan - (the two elements of plan and pace can be combined,
and are sometimes expressed as P2).

Adapt or Act - review plan, adapt if necessary, before committing to act on the plan (equating to action).

SUCCESS
Sense of direction, Understanding, Courage, Charity, Esteem, Self-confidence, Self-acceptance. Qualities featured
in the attitudes and thinking of successful personalities.

SUMO

Shut Up Move On.

Now a trademark associated with motivational speaker and author Paul McGee ('The SUMO Guy"), the SUMO
acronym is a powerful maxim for a positive successful approach to life and work. SUMO has strong connections
with the Transactional Analysis and NLP principles of self-reliance, emotional maturity, and focus on future not
blame.

SWOT

Strengths, Weaknesses, Opportunities, Threats. Famous marketing analysis headings acronym, and actually a very
useful framework for interpreting and explaining business situations. See the free SWOT analysis template and
examples, and free SWOT exercise team building game. See also the PEST acronym. Use either or both in
business presentations to impress and convince your audience that you know a bit about marketing.

TED
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Tell me, Explain to me, Describe to me.. Selling and communications (specifically questioning) acronym
reminding sales people to ask customers open questions, which gather helpful information about the customer's
requirements and needs. Open questions typically begin with what, how, which, when, who, why, and the TED
phrases, and are used for gather information and building rapport (which is dependent on good listening).

Closed questions, which generally prompt yes or no answers, typically begin with phrases such as: Is it..?, Do
you..?, Have you..?, Are they..?, etc., and are used for filtering (determining the relevance or fit' of
customer/offering) and for closing (for example, 'Would you like to go ahead...?") and for gaining commitment
('Do you the xyz aspect...?") and for clarification (‘Do you mean in the next week or the next month...?).

Sales people (and many other professional communicators) often use closed questions when they should be using
open questions, and so TED is a very useful reminder. The TED questions, which for politeness can be prefaced
with the words 'Can you please..." are especially effective when questioning senior capable people who are happy
and comfortable to speak at length in giving a long explanation to a very short question. See questioning on the
sales training page. See empathy also, for help with listening and building rapport and trust, and for diffusing
conflict.

TOTB (thus TOTBoxer and TOTBoxing)

Think Outside The Box/Thinking Outside The Box. A TOTBoxer is a person who thinks outside the box - i.e.,
very creatively. TOTBoxing is thinking outside the box. Cleverer than a straightforward TOTB acronym, the
expression elegantly describes a creative thinker, or the creative act.

WIIFM

What's In It For Me?

The essential element of all successful communications and organizational initiatives, and the principle of
persuasion and influence. If there's nothing in it for the other person, they may hear but they won't really listen,
and without the WIIFM factor they'll never commit to action.

For business abbrebiations see link below:

http://www.abbreviations.com/acronyms/BUSINESS
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MODAL AUXILIARIES

A verb characteristically used with other verbs to express mood or tense.

necessary

Modal Verb Meaning Expressing Example
— I must stop when the traffic lights turn
to have to 100 % obligation P g
red.
must - - -
logical conclusion He must be very tired after such
to be very probable .
(deduction) enormous work
e not to be allowed to prohibition You must not smoke in the hospital.
to be able to ability I can swim
et to be allowed to permission Can | use your phone please?
it is possible possibility Smoking can cause cancer!
e When | was younger | could stay up all
to be able to ability in the past . y g yup
night and not get tired..
could to be allowed to more polite permission Excuse me, could I just say something?
it is possible possibility It could rain tomorrow!
to be allowed to permission May | use your phone please?
may _ - - - ;
it is possible, probable possibility, probability It may rain tomorrow!
to be allowed to more polite permission Might I use your phone please?
might . . weak possibility, I might come and visit you in America
g it is possible, probable p' . Y g . Y
probability next year, if | can save enough money.
i ?
e necessary necessity Need | say more*
lack of necessity/absence | I need not buy any tomatoes. There are
not necessary L . )
need not of obligation plenty in the fridge.
used to say or ask what
is the corcht o best 50 % obligation I should / ought to see a doctor. | have a
0 .
Should . g terrible headache.
thing to do
& t t ti
0 suggest an action or .
99 . . You should / ought to revise your
ought to to show that it is advice

lessons
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to be very probable

logical conclusion

He should / ought to be very tired after

(deduction) such enormous work

to suggest an action or
had better | [© show that it is advice You 'd better studied for you exam

necessary

Suggest a future 1% . I shall regret this for the rest of my life.
Shall future prediction .

a person usage Shall I go first?
Suggest a future . .
gg . . I will graduate next summer. Will you

ol prediction and used to future prediction

ask questions be here tomorrow?

To make an offer or for .
i offer Would you like a cup of coffee

proper questions
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Microsoft®

Word 2007 Tra

Word Quick Reference Card

MICROSOFT TUTORIALS

CustomC

Learn on Demand

Share this Word Cheat Sheet with
others or post it on your Website!

Word 2007 Screen Keyboard Shortcuts

The Office Button, located in the upper left-hand corner of .
the program window, replaces the File menu found in

previous versions of Microsoft Word. The Office Button menu
contains basic file management commands, including New, .
Open, Save, Print and Close.

Office Button

'y H =
= 4

j (i, Word Document
~ E Save the document in the default file

Open format.
=

Save a copy of the document
New

Word Template

| Save the document as a template that can
be used to format future documents.

i
Save

= @ Word 97-2003 Document
H SaveAs | > Save a copy of the document that is fully °
compatible with Word 97-2003.
£ A Print > Find add-ins for other file formats
“'QI'J & @) Learn about add-ins to save to other

formats such as PDF or XPS.

Quick Access Toolbar Title bar Close button
Office y ! ! !
4 s D entl - Microsoft Word S e e
Button— '3 i ‘ & ==
—/ Home Insert Page Layout References Mailings Review View (7]
= Calibri (Body) 11 - A ‘% A
B B I U~ abex, x| £y Ribbon
Paste = — = Quick Change | Editing
- F |22 A Aar||A & |24 1) Styles~ Styles~ ||~
Clipboard = Font ([} Paragraph ] Styles i}
E‘ & Ruler
Insertion e r
point — | E
Vertical
Document scroll bar
window
Horizontal v
scroll bar 2
= o
| 3
il i T ]
Page:1of1 | Words:0 (B = = |gees) U
Status bar View buttons Zoom slider

The Fundamentals

To Create a New Document: Click the
Office Button, select New, and click
Create, or press <Ctrl> + <N>.

To Open a Document: Click the Office
Button and select Open, or press
<Ctrl> + <0>.

To Save a Document: Click the @]
Save button on the Quick Access
Toolbar, or press <Ctrl> + <§>.

To Save a Document with a Different
Name: Click the Office Button, select
Save As, and enter a new name for the
document.

To Preview a Document: Click the
Office Button, point to the Print list
arrow, and select Print Preview.

To Print a Document: Click the Office
Button and select Print, or press <Ctrl>
+<P>.

To Undo: Click the (2] Undo button on

General
Open a Document <Ctrl> + <O>
<Ctrl> + <N>

<Ctrl> + <S>

Create New
Save a Document

Print a Document <Ctrl> + <P>
Close a Document <Ctrl> + <W>
Help <F1>
Editing

Cut <Ctrl> + <X>
Copy <Ctrl> + <C>
Paste <Ctrl> + <V>
Undo <Ctrl> + <Z>

Redo or Repeat <Ctrl> + <Y>

Formatting

Bold <Ctrl> + <B>
Italics <Ctrl> + <I>

Underline <Ctrl> + <U>
Align Left <Ctrl> + <L>
Center <Ctrl> + <E>
Align Right <Ctrl> + <R>
Justify <Ctrl> + <J>

Navigation and Layout
Up One Screen <Page Up>

Down One Screen <Page Down>

Beginning of Line  <Home>

End of Line <End>

Beginning of <Ctrl> + <Home>
Document

<Ctrl> + <End>
<F5>

End of Document

Open the Go To
dialog box

Text Selection

j Prepare » "ﬂ Other Formats the Quick Access Toolbar or press <Ctrl> | To Select: Do This:
0 Open the Save As dialog box to select from +<2>. A Word Double-click the word
- EVI hpesiie e ipss o To Close a Document: Click the [ A Sent b 4 hold <Ctrl> and
Close button or press <Ctrl> + <W>, entence  Fress and hoid <Girl>an
click anywhere in the
Publish » o To Get Help: Press <F1> to open the sentence
Help window. Type your question and i o .
5 g press <Enter>. A Line Click in the selection bar next
| Close .
- o To Exit Word: Click the Office Button fo the line
2] Word Options | | X Exit Word and click Exit Word. A Paragraph Triple-click the paragraph
Everything <Ctrl> + <A>
CustomC Customizable Computer Training Word Quick Reference © 2008 CustomGuide
Learn on Demand v Courseware v Online Learning v Skills Assessments www.customguide.com | Phone 888.903.2432

100



Formatting

Home
=

Paste

Calibri (Body) e R A [ S ==

. A~

B 7 U - abe x, X' Aa~

Clipboard ™ Font

Dialog Box Launcher

» To Cut or Copy Text: Select the text you want to cut or copy and dick the
[?.Culu'[:(bwbdbnhﬂle()ﬁ)boadgupunmeHumetd:.
» ToPaste Text Place fhe inserfion paint where you want fo paste and click

IheEPasbbuﬂmhmeCﬁi)oadgupmmeHunetd:.

To Format Selecled Text Use the commands in the Font group on the
Home tab, or dick the Dialog Box Launcher in the Font group to open the
Font dialog box.

To Copy Formalting with the Foimat Painter: Select the text with the
fanﬁiilgyu:mﬂbcopymdcid(ﬂleﬁFomﬂPailﬂerhﬂmhme
Clipboard group on the Home tab. Then, select the text you want to apply
the copied formalting to.

To Change Paragraph Alignment: Select the paragraph{s) and diick the
appropriate aignment button (= Align Left, (= Cealer, = Alion Right,
or[Z! Jusiify) in the Paragraph group on the Home 1ab.
TolndenlaPamgaph:Cid(IheElnu‘easelndentmﬂmhme
Paragraph group on the Home tab.

To Decrease an Indent: Click the (= Decrease Indent bution in he
Paragraph group on he Home tab.

To Add a Tab Stop: Click the [ Tab alignment bax on the Ruler untl you
see the type of tab you want o insert. Then, dick on the Ruler where you
want fo insert fhe tab siop.

To Adjust or Remove a Tab Stop: Click and drag the L tab stop fo he
desired posifion on the Ruler. Click and drag fhe L {ab stop off the Ruler fo
remove it

+ To Insert a Table: Click the Insert tab on the Ribbon, dick the Table button
in fhe Tables group, and salect Insert Table from the menu.

= ToInsert a Column or Row: Ciick the Layout tzb under Table Todls and
wse the commands localed in the Rows & Cdumins group.

» To Delete a Column or Row: Select the column or row you want to delele,
click the Lagpourt tab under Table Toals, dick the Delele button in the Rows
& Columns group, and select an appropriate opfion from fhe menu

+ To Adjust Column Width or Row Height: Select the column or rowyou
want o adjust, dick the Layout tab under Table Tooks, and use the
commands located in e Cell Size group.

Mail Merge

1. Select a document type: Click the Maflings tab on the Ribbon, click the
Starl Mail Merge button in the Start Mal Merge group, and select the type
of document you want to areale.

2 Connect the document o a dala source: In the Start Mal Merge group on
the Mailings tab, click the Selecl Recipients button.

3. Refine recipients: In the Start Mall Merge group on the Malings tab, diick
the Edit Recipient List buiion.

4. Insert merge fields: Posilion the insettion point where you want to insert
the menge fieldis} and use the commands found in the Wrile & Insert Relds
group on the Mailings tab.

5. Preview your letfers: In he Preview Resulls group on the Mallings tzb,
ciick he Preview Resulls button.

6. Complele the merge: In the Fnish group on the Malings tab, dick the
Finish & Merge button and select an aption from the Est.

=, Ty «
= | &

‘% 44 Find ~

A

24|19 | | assbcenc| AsBbccDe AaBbC:
Change

" Styles~

Style ] Editing

Group

2ac Replace

i T Normal | T No Spaci.. Heading1l

5 Select~

+ To Change Paragraph Line Spacing Click fhe |*= "~ Line Spacing bulton in
the Paragraph group on the Home tab and select an option from the Bst.

* To Creale a Bulleled or Numbered List: Select the paragraphs you want to
bullet or number and click the [=_ Bullels or /= Numbering button in the
Paragraph group on the Home tab.

« To Change a Document’s Margins: Click he Page Layoutl tab on the
Ribbon, dick the Margins. button in the Page Setup group, and select a
setfing.

+ To Change Page Orientation: Click the Page Layout iab on the Ribbon, click
the Orientafion bution, and select an option from the st

+ To Insert a Header or Fooler: Click the Insest {ab on the Ribbon and click
the Header or Footer bution in the Header & Fooler group.

» To Insert a Manual Page Break: Click the Inseri tab on the Ribbon and dick
the Page Break bution in the Page Setup group.

¢ To Insert a Section Break: Click the Page Layout tab on the Ribbon, click
the Breaks button in the Page Setup group, and select the type of break you
want fo insert.

« To Comect a Spelling Ermor: Right-ciick the emor and select a comeclion from
the contexiual menu. Or, press < > fo un the Spell Chedker.

. ToFindTm:Cicklle/HFindhﬂmhﬂleEdiiggluponlleHamH).
+ ToReplace Text: c&kﬂeERephoebdtmhmeEdiiggmonhe
Home tab.

« To Move Text with the Mouse: Select the text you want fo move, drag the
text 10 @ new location, and release the mouse bution.

Tables Drawing and Graphics

» ToInsert a Clp At Graphic: Click the Inseri tab on fhe Ribbon and click the
Clip Ari button in the IBusiraions group. Type the name of whal you're
looking for in the “Search for” bax and click Go.

+ To Insert aPiclure: Click he Inserl tab on the Ribbon and click the Piclure
button in the Busirations group. Find and select the picture you want to insert
and click Insert.

¢ To Adjust Text Wrapping: Double-click the object, diick the Text Wrapping
butfon in the Amrange group, and select an oplion from the Bst.

+ ToDraw aShape: Click the insert iab on fhe Ribbon, dlick the Shapes
button in the Shapes group, and select the shape you went o insert. Then,
diick where you want to draw the shape and drag unfil the shape reaches e
desired size. Hold down the <Shifl= key while you drag to draw a perfecily
propartioned shape or siraight ne.

+ To Move an Object: Click the object and drag it o a newlocation. Release
the mouse bution when you're finished.

» ToResize an Object- Click he object bo select it, click and drag one of ils

sizing handles {7}, and release the mouse button when the object reaches

the desired size. Hold down the <Shifl> key while dragging to maintain the
object’s propartions while resizing it

To Delete an Object Select the object and press the <Delele- key.

« To Format an Object: Double-click fhe object and use the commands located
on the Format tab.

« To Insert a WordArt Object Click the Insest tab on the Ribbon, click the
WordArt button in the Text group, and select a design from the WordArt
Gallery. Enter the fext you want WordArt fo formal and adjust the font type
and size, if necessary. Click OK.
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Microsoft®

Excel 2010

Quick Reference Card
The Excel 2010 Screen

The Fundamentals

Quick Access Toolbar Title bar Close button
Formula Bar
i d s Bookl - Microsoft Excel o[
File tab—fJI ome | imet  Pagelsout  Fomuss  Data  Review 0 @od T
| =04 caibn cm v = om gl & Geneat - [H}Conditionsi Formatthg~ Feinsetr X - A( }} i
'@ BZU- AN EEBE- S % 0 G FomatasTavle- P Detete - | (- L — Ribbon
s P Sot& Find &
P me S A  EE Y | wa ‘ Biromut~ | @ s o
pbosrd ) : Numbe pyall
Name —— a1 . = &
box [a 8 D 3 F G H ! ] [3 i~
1 1 | T |
2
3 Active cell Columns
4
=
6
7
8
5 — Rows
10 Scroll
1 bars
12
13
14
15
16 —J B
W 4 » ¥ | Sheetl - Sheet2 ~Sheetd "1 M« [
Ready | | | (=)0 @ 100% (=) } 3
T 1 I |
T |_|_|
Worksheet tabs |

View buttons Zoom slider
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Keyboard Shortcuts

General

Open a Workbook <Ctrl> + <O>
Create New <Ctrl> + <N>
Save <Ctrl> + <S>

<Ctrl> + <P>
<Ctrl> + <W>

Preview and Print
Close a Workbook

Help <F1>
Run Spelling Check  <F7>
Calculate worksheets <F9>
Create an absolute, <F4>

normal, or mixed reference

Navigation:
Move Between Cells ~ <T>, <{>,

<>, <>
Right One Cell <Tab>
Left One Cell <Shift> + <Tab>
Down One Cell <Enter>
Up One Cell <Shift>+<Enter>]
Down One Screen <Page Down>
Up One Screen <Page Up>

To Cell A1 <Ctrl>+<Home>

. . . . To Last Cell <Ctrl> + <End>
w4 The File tab menu and Backstage view contain commands o Cell addresses: Cells are referenced by Go To Dialog B <F5>
for working with a program’s files, such as Open, Save, addresses made from their column letter 0 1o Dialog Box
Close, New, and Print. and row number, such as cell A1, A2, B1, Edit
§ B2, etc. You can find the address of a cell Iting
o To Create a New Workbook: Click . Cut <Ctrl> + <X>
N ) by looking at the Name Box.
the File tab and select New, and click Copy <Ctrl> + <C>
n Create, or press <Ctrl> + <N>. e To Select a Cell: Click a cell or use the Past <Ctrl> + <V>
i save To O Workbook: Click the Fil keyboard arrow keys to select it. aste d
o To Open a Workbook: Click the File . Undo <Ctrl> + <Z>
B save s tab and select Open, or press e To Select a Cell Range: Click and drag to Redo <Ctrl> + <Y>
> Open <Ctrl> + <0>. select a range of cells. Or, press and hold )
il down the <Shift> key while using the Find <Ctrl> + <F>
o Close ¢ To Save a Workbook: Click the y 9 Repl <Ctrl> + <H>
Save button on the Quick Access <arrow keys> to move the mouse eplace "’
Info Toolbar, or press <Ctrl> + <S>. pointer to the last cell of the range. Select All <Ctrl> + <A>
2 To Preview and Print a Workbook: e To Select an Entire Worksheet: Click the | Edit active cell <F2>
- Click the File tab and select Print, or Select All button where column and row Clear cell contents <Delete>
Now press <Ctrl> + <P>. headings meet. Or, press <Ctrl> + <A>.
_ « To Undo: Click the "] Undo button = To Minimize the Ribbon: Click the Formatting
Print on the Quick Access Toolbar, or Minimize Ribbon button on the Ribbon. Bold <Ctrl> + <B>
. press <Ctrl> + <Z>. Or, press <Ctrl> + <F1>. Or, right-click a ltalics <Ctrl> + <I>
Save & Sen . tab and select Minimize Ribbon from the .
« To Redo or Repeat: Click the 2] contextual menu. Underline <Ctrl> + <U>
Help Redo button on the Quick Access ToCh P Settinas: Click th Open Format Cells  <Ctrl> + <Shift>
E2 Add-Ins - Toolbar, or press <Ctrl> + <Y>. The * _° ange Frogram ‘e ings: Llick the Dialog Box + <F>
2 < ) . File tab and select Options.
last command is repeated if Undo Select All <Ctrl> + <A>
2 Options was not previously used. o To Use Zoom: Click and drag the zoom
i i i i Select entire row <Shift>+<Space>
I « To Close a Workbook: Click the * | ;'(')d:r:lt‘(’)ﬁ‘tea'r‘]’g gggﬂ‘:n%'utfgﬁz t:: . P
Close button, or press <Ctrl> + <W>. e slider Select entire column <Ctrl>+<Space>
. ' Hide selected rows  <Ctrl> + <9>
" Kol vindow Type youraestonand 10 Change Views: CckaViewbutonin | o 000 L o
P <Ent '> ype yourq the status bar. Or, click the View tab and II € selecte d
press <Enter>. select a view. columns
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Editing Formatting

e To Edit a Cell’'s Contents: Select the cell and click the Formula Bar, or
double-click the cell. Edit the cell contents and press <Enter>.

o To Clear a Cell’s Contents: Select the cell(s) and press the <Delete> key.

e To Cut or Copy Data: Select cell(s) and click the Cut or @Copy button
in the Clipboard group on the Home tab.

* To Paste Data: Place the insertion point where you want to paste and click
the Paste button in the Clipboard group on the Home tab.

=4 To Preview an Item Before Pasting: Place the insertion point where you
want to paste, click the Paste button list arrow in the Clipboard group on the
Home tab, and select a preview option to view the item.

o To Paste Special: Select the destination cell(s), click the Paste button list
arrow in the Clipboard group on the Home tab, and select Paste Special.
Select an option and click OK.

* To Copy Using Auto Fill: Point to the fill handle at the bottom-right corner of
the selected cell(s), then drag to the destination cell(s).

o To Complete a Series Using AutoFill: Select the cells that define the series.
Click and drag the fill handle to complete the series.

o To Move or Copy Cells Using Drag and Drop: Select the cell(s) you want to
move or copy, position the pointer over any border of the selected cell(s), then
drag to the destination cells. To copy, hold down <Ctrl> key while dragging.

o To Insert a Column or Row: Right-click to the right of the column, or below
the row you want to insert. Select Insert from the contextual menu, or click the
Insert button in the Cells group on the Home tab.

o To Delete a Column or Row: Select the row or column heading(s). Right-
click and select Delete from the contextual menu, or click the Delete button in
the Cells group on the Home tab.

o To Insert a Comment: Select the cell where you want to insert a comment
and click the Review tab on the Ribbon. Click the New Comment button in
the Comments group. Type a comment and click outside the comment box.

o To Total a Cell Range: Click the cell where you want to insert the total and
click the Sum button in the Editing group on the Home tab. Verify the selected
cell range and click the Sum button again.

To Enter a Formula: Select the cell where you want to insert the formula.
Type = and enter the formula using values, cell references, operators, and
functions. Press <Enter> when you're finished.

To Insert a Function: Select the cell where you want to enter the function
and click the Insert Function button on the Formula Bar.

To Reference a Cell in a Formula: Type the cell reference (for example, B5)
in the formula or click the cell you want to reference.

To Create an Absolute Cell Reference: Precede the cell references with a $
sign or press <F4> after selecting cell(s) to make it absolute.

o To Use Several Operators or Cell Ranges: Enclose the part of a formula
you want to calculate first in parentheses.

e To Create a Chart: Select the cell range that contains the data you want to
chart and click the Insert tab on the Ribbon. Click a chart type button in the
Charts group and select the chart you want to use from the list.

=3 To Insert a Sparkline: Select the cell range that contains the data you want to
chart and click the Insert tab on the Ribbon. Select the sparkline you want to
insert from the Sparkline group. Select the cell or cell range where you want to
add the sparkline and click OK.

Formulas and Functions

o To Format Text: Use the commands in the Font group on the Home tab, or
click the Dialog Box Launcher in the Font group to open the Format Cells
dialog box.

To Format Values: Use the commands in the Number group on the Home
tab, or click the Dialog Box Launcher in the Number group to open the
Format Cells dialog box.

To Copy Formatting with the Format Painter: Select the cell(s) with the
formatting you want to copy and click the M Format Painter button in the
Clipboard group on the Home tab. Then, select the cell(s) you want to apply
the copied formatting to.

To Apply a Cell Style: Select the cell(s) you want to apply a cell style to.
Click the Cell Styles button in the Styles group of the Home tab on the
Ribbon and select a style from the gallery.

To Format a Cell Range as a Table: Select the cells you want to apply table
formatting to. Click the Format as Table button in the Styles group of the
Home tab on the Ribbon and select a table format from the gallery.

To Apply a Document Theme: Click the Page Layout tab on the Ribbon,
click the Themes button in the Themes group, and select a theme from the
gallery.

2 To Apply Conditional Formatting: Select the cells to which you want to
apply conditional formatting. Click the Conditional Formatting button in the
Styles group of the Home tab. Select the formatting scheme you wish to use,
then set the conditions in the dialog box.

To Adjust Column Width or Row Height: Drag the right border of the
column header, or the bottom border of the row header. Double-click the
border to AutoFit the column or row according to its contents.

Workbook Management

o To Insert a New Worksheet: Click the Insert Worksheet tab next to the
sheet tabs at the bottom of the program screen. Or, press <Shift> + <F11>.

[=

To Delete a Worksheet: Select the sheet want to delete, click the Delete
button in the Cells group on the Home tab, and select Delete Sheet. Or, right-
click the sheet tab and select Delete from the contextual menu.

e To Rename a Worksheet: Double-click the sheet tab, enter a new name for
the worksheet, and press <Enter>.

To Change a Worksheet’s Tab Color: Right-click the sheet tab, select Tab
Color, and choose the color you want to apply.

To Move or Copy a Worksheet: Click and drag a tab to move a worksheet.
Hold down the <Ctrl> key while clicking and dragging to copy the worksheet.

To Split a Window: Drag either the vertical or horizontal split bar (located
near the scroll bars) onto the worksheet.

To Freeze Panes: Place the cell pointer where you want to freeze the
window, click the View tab on the Ribbon, click the Freeze Panes button in
the Window group, and select an option from the list.

To Select a Print Area: Select the cell range you want to print, click the Page
Layout tab on the Ribbon, click the Print Area button in the Page Setup
group, and select Set Print Area.

To Adjust Page Margins, Orientation, Size, and Breaks: Click the Page
Layout tab on the Ribbon and use the commands in the Page Setup group,
or click the Dialog Box Launcher in the Page Setup group to open the Page
Setup dialog box.

To Protect or Share a Workbook: Click the Review tab on the Ribbon and
use the commands in the Changes group.

=4 To Recover Autosaved Versions: Click the File tab on the Ribbon and
select Info. Select an autosaved version from the Versions list. Or, click the
Manage Versions button and select Recover Draft Versions.
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Microsoft®

PowerPoint 2010

Quick Reference Card

Slides
tab

Outline
tab

Quick Access Toolbar

Title bar

Close button

ls)a -

File

0= Presentation] - Microsoft PowerPoint
Home | Insert Design Transitions  Animations

Calibei (Headings, » 44

[R3

:‘ TP
) :
. B 1 U S weiV-2,- A-

SlideShow  Review  View

=l save
Save As
(25 Open

[ Close

Info
el
New

Print

Save & Send

Help

52 Add-ns -
|z] Options

B3 Exit

Click to add title

Click to add subtitle

| Click to add notes

Slide 1 of 1 | “Office Theme"

| Drawing Toal: ) § |
Format - @
R —we
- P Ea S
& s:;‘} ‘J /‘-ﬁ s Ribbon
‘ Slide
] pane
Z Notes
[Eeae axC-0 Gt pane

Status bar

- I

=2 The File tab menu and Backstage view contain
commands for working with a program’s files,
including New, Open, Save, Print and Close.

"

To Create a New Presentation:
Click the File tab, click New, and click
Create. Or, press <Ctrl> + <N>.

To Open a Presentation: Click the
File tab and click Open, or press
<Ctrl> + <0>.

To Save a Presentation: Click the

i save button on the Quick Access
Toolbar, or press <Ctrl> + <S>,

To Save a Presentation with a
Different Name: Click the File tab,
click Save As, enter a new name for
the presentation, and click Save.

To Preview and Print a
Presentation: Click the File tab and
click Print, or press <Ctrl> + <P>.

To Close a Presentation: Click the
File tab and click Close, or press
<Ctrl> + <W>,

To Get Help: Press <F1> to open the
Help window. Type your question and
press <Enter>.

To Exit PowerPoint: Click the File
tab and click Exit.

View buttons  Zoom slider

To Insert a New Slide: Click the Home tab
and click New Slide in the Slides group, or
press <Ctrl> + <M>.

To Change the Slide Layout: Click the Home
tab, click the Layout button in the Slides
group, and select a layout.

To Return a Slide to its Default Settings:
Click the Home tab and click the Reset button
in the Slides group.

To Apply a Document Theme: Click the
Design tab on the Ribbon, click the = More
button in the Themes group, and select a
theme from the gallery.

To Change the Slide Background: Click the
Design tab on the Ribbon, click the
Background Styles button in the Background
group, and select a background.

To View the Slide Master: Click the View tab
on the Ribbon, click the Slide Master button in
the Master Views group, and click the Slide
Master or the appropriate Layout Master in
the Outline pane.

To Insert a Header or Footer: Click the Insert
tab on the Ribbon and click the Header &
Footer button in the Text group. Select the
option(s) that you want and click Apply or
Apply to All.

3 To Add a Section: Click the Home tab on the

Ribbon, click the Section button in the Slides
group, and click Add Section.
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General

Open a Presentation  <Ctrl> + <O>
<Ctrl> + <N>
<Ctrl> + <S>
<Ctrl> + <P>
<Ctrl> + <W>

<Ctrl> + <M>

Create New

Save a Presentation
Print a Presentation

Close a Presentation
Insert a New Slide

Help <F1>
Editing

Cut <Ctrl> + <X>
Copy <Ctrl> + <C>
Paste <Ctrl> + <V>
Undo <Ctrl> + <Z>
Redo or Repeat <Ctrl> + <Y>
Find <Ctrl> + <F>
Replace <Ctrl> + <H>
Select All <Ctrl> + <A>

Navigation—Go To:
The Next Slide
The Previous Slide <Backspace>

<Spacebar>

Slide Show Delivery

Begin Slide Show <F5>

Resume Slide Show  <Shift> +
<F5>

End Slide Show <Esc>

Jump to Slide <Slide #> +
<Enter>

Toggle Screen Black <B>

Toggle Screen White <W>

Pause Show <S>

Show/Hide Pointer <A>

Change Arrow to Pen <Ctrl> + <P>

Change Pen to Arrow  <Ctrl> + <A>

Erase Doodles <E>

Formatting

Bold <Ctrl> + <B>

Italics <Ctrl> + <I>

Align Left <Ctrl> + <L>

Center <Ctrl> + <E>

Justify <Ctrl> + <J>

c usto m @ u | d e Customizable Computer Training

Learning Vv Courseware

Online

v'Online Learning v Skills Assessments

PowerPoint Quick Reference © 2011 CustomGuide
www.customguide.com | Phone 888.903.2432

104



Formatting

e To Cut or Copy Text: Select the text you want to cut or copy and click the
% Cut or| =2 Copy button in the Clipboard group on the Home tab.
To Paste Text: Place the insertion point where you want to paste and click

the " Paste button in the Clipboard group on the Home tab.

To Format Selected Text: Use the commands in the Font group on the
Home tab, or click the Dialog Box Launcher in the Font group to open the
Font dialog box.

e To Copy Formatting with the Format Painter: Select the text with the
formatting you want to copy and click the # Format Painter button in the

Clipboard group on the Home tab. Then, select the text you want to apply the
copied formatting to.

To Change Paragraph Alignment: Select the paragraph(s) and click the
appropriate alignment button ( = Align Left, = Center, = Align Right,
or = Justify) in the Paragraph group on the Home tab.

To Create a Bulleted or Numbered List: Select the paragraphs you want to

bullet or number and click the | ‘= Bullets or = Numbering button in the
Paragraph group on the Home tab.

To Change Paragraph Line Spacing: Select the paragraph(s), click the
‘2" Line Spacing button in the Paragraph group on the Home tab, and
select an option from the list.

e To Correct a Spelling Error: Right-click the error and select a correction
from the contextual menu. Or, press <F7> to run the Spell Checker.

The Outline Pane
5 |- Theslidestab [o [= ]

contains a | MARKETING
thumbnail image of STRATEGY

every slide in the Presented by

. . Jeanne Trudeau
presentation; click a

. . Important Facts
— thumbnailtojump to| g Remember
that slide. You can *Time is of the
also rearrange, add,

essence
. + Manage it wisely
or delete slides
here.

The Outline tab
focuses on the
content of the
presentation. Use
this tab when you
want to adjust the
textual structure
or add large
amounts of text.

+Two heads are
better than one

(B Normal view: This is the default view in
PowerPoint 2010. Normal view includes the
;. Outline pane, Slide pane, and Notes pane.

oo

B2 Slide Sorter view: Displays all the slides
in the presentation as thumbnails (tiny images).
Use Slide Sorter view when you want to
rearrange the order of slides or add transition
effects between slides.

Ed Reading View: Similar to Slide Show
view, it displays the presentation in a window
with simple controls, making it easy to review.

= Slide Show view: Displays the
presentation as an electronic slide show.
Whenever you deliver a presentation in front of
an audience, Slide Show view is definitely the
view you want to use.

MARKETING STRATEGY

Images, Multimedia, and Objects

[=
B

el

To Insert a Picture: Click the Insert tab on the Ribbon and click the Picture
button in the lllustrations group. Find the picture you want to insert and click
Insert.

To Insert a Clip Art Graphic: Click the Insert tab on the Ribbon and click the
Clip Art button in the Images group. Type the name of what you're looking for
in the “Search for” box and click Go.

To Insert a Video file: Click the Insert tab on the Ribbon and click the Video
button in the Media group. Find the video you want to insert and click Insert.

¢ To Insert a Video from the Web: Click the Insert tab on the Ribbon, click the

Video button list arrow in the Media group, and select Video from Web Site.
Paste the video’s Embed code into the Insert Video from Web Site dialog box
and click Insert.

To Insert an Audio clip: Click the Insert tab on the Ribbon, click the Audio
button list arrow in the Media group, and select Audio from File. Find the
audio clip that you want to insert and click Insert.

To Draw a Shape: Click the Insert tab on the Ribbon, click the Shapes
button in the Shapes group, and select the shape you want to insert. Then,
click where you want to draw the shape and drag until the shape reaches the
desired size. Hold down the <Shift> key while you drag to draw a perfectly
proportioned shape or straight line.

To Insert SmartArt: Click the Insert tab on the Ribbon and click the
SmartArt button in the lllustrations group. Select the SmartArt you want to
insert and click OK.

To Format an Object: Double-click the object and use the commands located
on the Format tab.

To Move an Object: Click the object and drag it to a new location. Release
the mouse button when you're finished.

To Resize an Object: Click the object to select it, click and drag one of its
sizing handles (©), and release the mouse button when the object reaches
the desired size. Hold down the <Shift> key while dragging to maintain the
object’s proportions while resizing it.

To Delete an Object: Select the object and press the <Delete> key.

Transitions and Animation Effects

To Add a Slide Transition: Navigate to the slide you want to add a transition
to. Click the Transitions tab on the Ribbon, click the = More button in the
Transition to This Slide group, and select a transition effect.

To Add an Animation Effect to an Object: Select the object that you want to
animate, click the Animations tab on the Ribbon. Click the '~ More button in
the Animation group, and select an animation effect.

To Copy Animation Effects from One Object to Another: Select the object
with the animation effect you want to copy, click the Animations tab on the
Ribbon, and click the Animation Painter button in the Advanced Animation
group. Then, click the object you want to apply the copied animation effect to.

Slide Show Delivery

To Present a Slide Show: Click the Slide Show button on the status bar, or
press <F5>.

=4 To Use the Laser Pointer: In Slide Show view, press and hold down the

<Ctrl> key while clicking and holding the left mouse button.

To Use the Pen: In Slide Show view, press <Ctrl> + <P> and then draw on the
screen. Press <Ctrl> + <A> to switch back to the arrow pointer. Press <E> to
erase your doodles.

To Advance to the Next Slide: Press <Spacebar>. Or, click the left mouse
button.

To Go Back to the Previous Slide: Press <Backspace> or <Page Up>.

To Add Slide Timings: Click the Slide Show tab on the Ribbon and click the
Rehearse Timings button in the Set Up group. Navigate through the
presentation, pausing on each slide for the amount of time you wish to display it
during your show. Click Yes to save your timings.

To End a Slide Show: Press <Esc>.
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Tips for Effective Presentations

Presentations are mostly practiced by students and professionals, and they are a great way to convey ideas as well
as educate and convince people. Giving a presentation is not an easy task; it requires substantial research,
organization, public speaking skills, and self-confidence. A good presenter has the ability to engage his or her
listeners from beginning to end and compel them to take action. Those who wish to learn presentation skills can
get training from expert presenters through classes or courses, or they can follow presentation tips that are
available on the Internet. Here are some great tips and tricks for effective presentations, as well as links to related
websites.

Here are three of our blog posts for presenters.

Public Speaking

Presentation Exercises

Two Minutes

Organizing Your Presentation

Choose an appropriate presentation structure: topical, chronological, classification by categories, problem and
solution, or cause and effect.

Divide the body of your presentation into three to five main points.

The conclusion should include a summary of the main points of the presentation and leave the audience with
something that is worth remembering and pondering.

Include questions in your presentation, which should be asked once every 10 minutes to engage the audience.

The final slide should contain a message thanking the audience, your contact details, and information about the
availability of speaker notes, materials, and feedback tools.

Public Speaking Tips

Avoid slang and jargon.

Use anecdotes and practical examples to make complicated concepts more comprehensible.
Speak in varying tones and pitches to give emphasis to certain words and ideas.

Deliver your speech slowly and clearly.

Make sure that the people sitting at the back of the hall can hear you clearly, but do not speak so loud that it
appears as if you are shouting.

Maintain an upright but relaxed posture while you are speaking, and do not lean forward or backward.
Leave your arms on the podium or by your sides when you are not using them to make gestures.
When gesturing, make sure that it is natural and spontaneous.

Maintain eye contact with the audience.

Wear clothes with simple cuts and neutral tones, and make sure that they are comfortable.
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http://www.accuconference.com/blog/Public-Speaking.aspx
http://www.accuconference.com/blog/Presentation-Exercises.aspx
http://www.accuconference.com/blog/2-Minutes-to-Save-The-World.aspx

Presentation Design

Do not overload slides with a lot of text.

Use the PowerPoint Notes to remind yourself what to say when a certain slide is being shown.
Prepare a Table of Contents slide with the “Summary Slide” feature.

Include a slide that shows your company logo.

Arrange slides according to topics.

Try to make the length of text lines similar throughout the slide.

Recommended font for slide title is San Serif, and font size should be 44.

Font size for subtitles should be 28 to 34, with bold font.

Use dark font over light background and light font over dark background to enhance clarity.
Use graphics only when appropriate.

You can press “W” or “B” to clear the screen temporarily during your presentation, and resume the presentation
by pressing “Enter”.

Charts, Facts, and Statistics

Use as few numbers as possible during your presentation, preferably, no more than 12 numbers, because they can
cause confusion.

Try not to use more than one number in a sentence.

Round numbers up to the nearest whole number.

If you are showing sales statistics, you should concentrate on one market throughout your presentation.
Use a smaller font to cite sources for statistics.

Label all your charts clearly.

Use elements from drawing toolbar to create more attractive charts.

Numbers in charts can be difficult to view and understand.

Try to find ways other than columns and rows to present your data.

Take note that PowerPoint automatically deletes portions of charts imported from Excel, leaving only about 5
inches on the left.

Resources: https://www.accuconference.com/resources/effective-presentations.html

Create Better Presentations: Tips for creating better presentations from Microsoft.

Presentation Tips and Tricks: Follow these tips to make your presentation a big success.
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https://www.accuconference.com/resources/effective-presentations.html
http://www.microsoft.com/atwork/skills/presentations.aspx
http://www.cgl.uwaterloo.ca/~csk/presentations.html

How to Make Presentations: A comprehensive lesson on how to create and deliver the best presentations.

Giving Excellent Presentations: Document that contains tips for using various presentation visual aids.

Organizing Presentation: Make the right preparations for you presentation with these great tips.

Making Oral Presentations: Learn how to make oral presentations from this website.

Oral Presentation Tips: Things to consider before making an oral presentation.

Academic Presentations: Guidelines for delivering good presentations in school.

Emergent Manager Presentation Skills: Helpful presentation tips for emergent managers.

Designing Presentation Visuals: Excellent advice on how to design presentation visuals.

Presenting with PowerPoint: Valuable suggestions for PowerPoint presentation.

PowerPoint Presentation Advice: A collection of tips and tricks for making PowerPoint presentations.

Presentation Anxiety: Find out how you can overcome presentation anxiety.
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